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Introduction
Axiom Software is an enterprise performancemanagement application with full-featured planning and
reporting functionality. Once the system has been configured to your organization's requirements, plan
files and reports aremade accessible to end users. This guide explains how to work with plan files and
reports that have already been created by administrators and other power users.

� Intended audience
This guide is intended for all users of Axiom Software.

� What is covered in this guide?
This guide covers the following:

l Introduction to the Axiom Software user environment, including menus and basic navigation
l How to use plan files to develop planning data for your responsibility areas
l How to use reports to view Axiom Software data
l File output options

� What is not covered in this guide?
This guide does not cover any administration or file setup activities. For more information, see the other
guides delivered with the system. All documentation for Axiom Software can also be accessed using the
Axiom Software Help Files.

� Axiom Software Client versions
This guide discusses functionality that is available in the Axiom Desktop Client (Excel Client and Windows
Client). Screenshots of features may show either the Excel Client or theWindows Client. The Axiom
Software functionality is virtually identical in both environments.

The user features discussed in this document do not apply to the AxiomWeb Client or to use of Axiom
forms in any client. When using web-enabled Axiom forms, all user interaction depends on the
configuration of the particular form.

1
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Axiom Software Basics
This section discusses the basics of working with the Axiom Software user interface in the Desktop Client,
including:

l The home page
l Axiom ribbon menus
l Axiom Assistant area and task panes
l Favorites and recent items

Home page
The home page is a designated file that automatically opens when you enter Axiom Software. The home
page that you see is determined by your system administrator. The home pagemay contain reporting
data, plan deadlines, announcements, or other information. If you have any questions about the home
page or its contents, please contact your system administrator.

The default label for the home page is Home. The name on the file tab may be different if the
administrator has assigned an alternate home page.

The home pagemay be configured as non-closeable, which means it is always open while you are
working in Axiom Software. If the home page is closeable, you can close and open it as follows:

l To close the home page, click the X button in the file tab, or right-click the file tab and select Close.

NOTE: The Close All and Close All But This options do not close the home page; it must be
individually closed. If you are using the Axiom Excel Client and the home page is the last open
file, then closing the home page will close the application.

l To reopen the home page in the current session, click the Show Home button in theDisplay
group on the Axiom tab. (In product systems, this button may be located on theMain tab.) This
button can also be used to jump directly to the home page when multiple files are currently open.

System administrators can customize the default home page, or assign each user or role an alternate
home page. Additional files may also be opened at startup. For more information, see the System
Administration Guide.

2
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Axiommenu
All major Axiom Software files and features can be accessed using the Axiom tab on the ribbon.

Example Axiommenu (Windows Client)

The Axiom tab contains the following groups:

Group Description

File Groups Access plan files, templates, and drivers. Create and process plan files.

Reports Access existing reports and create new reports.

Administration Manage tables, imports, file groups, security, and other system administration
features.

File Options Perform actions on Axiom files, such as saving the file, refreshing data, and
inserting planning rows.

File Output Perform file output actions on Axiom files, such as taking snapshot copies or using
file processing.

Display Manage display options for the Axiom Software user environment. Show or hide
the home page, the formula bar, or sheet headings.

Advanced Access file setup tools and other advanced options.

Help Open Axiom Software Help, and view information about the current Axiom
Software system.

Exit Close Axiom Software.

NOTE: This topic discusses the default contents of the Axiom ribbon tab. This ribbon tab can be
customized per installation, or even removed and replaced with other custom ribbon tabs. You may
also be assigned additional custom ribbon tabs that provide access to Axiom Software functionality.

The specific groups and features available on themenu depend on your security settings. For example,
the File Groups group only displays the file groups that you have access to, and only allows opening plan
files unless you have been granted the security rights to access other file group items like drivers and
templates. Most end users will not see the Administration group or the Advanced group, unless they
have been granted access to a feature in that area.
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Spreadsheet features are available on other ribbon tabs, to perform spreadsheet formatting and other
related tasks. If you are using the Excel Client, then you have access to all of the normalMicrosoft Excel
ribbon tabs. If you are using theWindows Client, a Home tab provides access to commonly-used
spreadsheet features. For more information, see Using spreadsheet features.

NOTES:
l Administrators have access to a second Axiom-related tab, named Axiom Designer. This tab

can be used to assist with file development.

l When using the Axiom Excel Client with Excel 2013 or 2016, each file opens within its own
window, and each windowmaintains its own set of ribbon tabs and task panes. This means
that as you switch windows, the current state of the ribbon may be different in each window.
For example, you may have the Home tab active in one window, but if you switch to another
window the Axiom tab will still be active.

Axiom file tabs
You can open multiple files at a time in Axiom Software. Each file that you open—whether it is an Axiom
file or a regular Excel spreadsheet—is represented by an Axiom file tab. These tabs are located below the
ribbon and above the spreadsheet area.

You can quickly navigate between open files by using the Axiom file tabs. You can also perform certain
basic file actions directly from these tabs.

Multiple file tabs open in the AxiomWindows Client

The tab displays the name of the file, and an icon identifying the file type. You can hover your cursor over
the tab to see a tooltip with more information about the file. For example, if the file is a plan file, the
tooltip shows what file group the file belongs to.
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You can navigate between files by clicking on the tabs. To close a file, click the X icon in the right-hand
side of the tab. Additional file close options are available on the right-click menu.

� Opening multiple files in the Axiom Excel Client
When using the AxiomWindows Client, multiple files open within the samewindow. As you move from
file to file, you are changing the active file within the current window.

Microsoft Excel does not support the ability to open multiple workbooks within the samewindow.
Therefore when you open multiple files in the Axiom Excel Client, each file opens in a new Excel window.
The Axiom file tabs still display so that you have access to the right-click menu, however, when you click
on a file tab you are actually changing windows. This action may look different as compared to the
behavior when the files are all open in the samewindow. As an alternative to the file tabs, you can also
switch between files (windows) by using theWindows task bar, or by clicking Alt+Tab to move through
open windows.

The one-file-per-window behavior of Excel has the following functionality impacts:
l With the exception of the home page, web-enabled files cannot be opened as tabs within the

Axiom Excel Client. Instead, these files will open in the browser. This includes Axiom forms, web
reports, and data diagrams.

l The active ribbon tab and the active task pane aremanaged independently for each open window.
This means that as you change windows, your active ribbon and active task panemay be
different.

� File actions in the navigation pane
Right-click on a tab to perform one of the following actions on a file.

NOTE: If you are using the Axiom Excel Client, right-click options are only available on the currently
active file. In the AxiomWindows Client, right-click options are available on all open files.

Action Description

Save You can save the file using one of the following options:
l Save: Save the file and its data.
l Save File Only: Save only the file; do not perform a save-to-database.
l Save Data Only: Perform a save-to-database but do not save the file.

NOTE: In most cases, you should select Save, and Axiom Software will
perform all save operations that you have rights to perform and that the file
allows. Avoid saving only the file or only the data unless you understand the
potential ramifications. For more details, see the save discussion for the file
type that you are saving (for example, report or plan file).
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Action Description

Save As You can save a copy of the file locally, or to the Axiom Software file system
within the database:
l Save As (Local File): Save a copy of the file to any local or network folder

that you have access to. Note that if you save an Axiom file as a local file, it
is no longer managed by Axiom Software.
In the Axiom Excel Client, you can save the file using any file format that
your Excel version supports. In theWindows Client, you can save the file
as XLSM, XLSX, or XLS.
NOTE: The ability to save as a local file can be disabled on a per system
basis. For more information on system configuration settings, see the
System Administration Guide.

l Save As (Repository): Save a copy of the file to the Reports Library in the
Axiom Software database (or to another eligible location, depending on
the type of file being saved and your folder permissions). You must have
read/write permissions to at least one folder to use this option. This
option is not available for plan files.

Close Close the current file. This option is not available for startup files that have
been configured as non-closeable.

Close All Close all files except the home page and any non-closeable startup files.

Close All But This Close all files except the current file, the home page, and any non-closeable
startup files.

Add to Favorites Add the file to your list of favorites.

� File icons in the navigation pane
The following icons display on the file tabs, to identify files in the navigation pane.

Icon Description Tooltip Contents

The Home file l File name
l File location (in the Axiom Software file

system)
l Creation date

A report file l File name
l File location (in the Axiom Software file

system)
l Creation date
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Icon Description Tooltip Contents

A plan file l File name
l File group
l Plan file code
l Creation date

A template file l File name
l File group
l Creation date

A driver file l File name
l File group
l Creation date

A table opened in a spreadsheet l Table name
l Filter

An Excel file l File name
l File location
l Creation date

AxiomAssistant task panes
The Axiom Assistant area provides quick and easy access to Axiom files and features as you work
throughout the Axiom Software system. A variety of task panes are available to help you perform general
and context-sensitive tasks. Additionally, system administrators can create customized task panes for
use in this area.

The Axiom Assistant area is located in the left-hand side of the application, below the ribbon and to the
left of any opened files. By default, the area is expanded, and you can work with any of its available task
panes by clicking the side-tabs along the left-hand edge of the pane.
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Example Axiom Assistant area

� Available task panes
The task panes available to you in the Axiom Assistant area depend on your system configuration and
your security permissions. The following task panes may be available:

Task pane Description Availability

Data Source
Assistant

Helper tool to build data sources,
such as RefreshVariables,
DataLookup, and Grid.

This task pane is system-controlled and
displays if you have the appropriate
security permissions and the file is an
Axiom file.

Explorer Open files and other items that you
have access to, including favorites.

This task pane is included by default, but
may be disabled in your system or
restricted to only certain users.

File
Processing

Configure and perform file processing
for an Axiom file, such as to perform
multipass processing, file collect, or
batch processing.

This task pane is system-controlled and
displays if you have the appropriate
security permissions and the file is
enabled for File Processing.

Form
Assistant

Configure form settings for an Axiom
file, and preview the form.

This task pane is system-controlled and
displays if you have the appropriate
security permissions and the file is
enabled for Axiom forms.
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Task pane Description Availability

Messages View comments about the current
document, and add comments.

This task pane is system-controlled and
displays for all eligible documents.

Notifications View alert and system notifications
and open associated files.

This task pane is system-controlled and
displays if you have any active
notifications.

Process View process information and
complete process tasks. By default
this task pane only displays if it is
relevant to you (for example if you are
the assigned owner of a process task).

This task pane is included by default, but
may be disabled in your system.

Sheet
Assistant

Configure workbook and worksheet
settings for an Axiom file, including
Axiom queries.

This task pane is system-controlled and
displays if you have the appropriate
security permissions and the file is an
Axiom file.

Table View table details, set a filter, and
refresh the currently opened table.

This task pane is system-controlled and
displays when using Open Table in
Spreadsheet.

Workflow Work with currently assigned plan
files and complete workflow tasks. By
default this task pane only displays if
you have assigned tasks (current or
completed) for an active workflow.

This task pane is included by default in
older systems, but may be disabled in
your system or may use different
configuration settings to determine
visibility. Newer systems do not have this
task pane.

<Custom
Task Panes>

Your organization may have defined
one or more custom task panes for
your system.

Custom task panes may open
automatically when Axiom Software is
launched, or you may have access to the
Task Panes Library to open certain task
panes as needed.

The order of task panes in the Axiom Assistant area cannot bemanually changed. Your system
administrator has specified an order for the task panes that open when the system is started. System-
controlled task panes display after these startup task panes.

� Minimize Axiom Assistant
By default, the Axiom Assistant area is maximized when you first start Axiom Software. If desired, you can
minimize this area—for example, to gain more screen space while working on a file. When minimized, the
area displays as a thin strip along the left-hand side of the application, with one or more side-tabs for
each task pane.
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You can expand the Axiom Assistant area to perform a task, and then minimize it again when you are
finished.

l To minimize the Axiom Assistant pane, click the button in the header.

l To expand the Axiom Assistant pane, click the button in the collapsed header, or click on one of
the task pane tabs.

Axiom Software remembers the state of the Axiom Assistant (minimized or expanded) when you exit the
application, and will apply that state the next time you open Axiom Software on the samemachine.

It is not possible to completely hide the Axiom Assistant area when task panes are open, however, if no
task panes are open then the Axiom Assistant area is automatically hidden (and will automatically show
again when a task pane is opened).

� Opening task panes
In most cases, the task panes that you need to use will open automatically—you do not need to
manually open them.

l Certain task panes are configured to open automatically when Axiom Software is started, such as
the Explorer task pane. These task panes are considered to be "global" task panes that you may
want to use at any timewhile you work in the system.

l Other context-sensitive task panes only open when using certain features. For example, the File
Processing task pane only displays when you open a file that is enabled for File Processing. There
is no need to manually open the task pane because it will always be available when it is relevant
(and assuming that you have security permissions to view it).

If you have access to the Task Panes Library to open certain custom task panes as needed, then you can
open a task pane by double-clicking it in the Explorer task pane or the Axiom Explorer dialog.
Alternatively, one of your "startup" task panes might be used to open other task panes.

For example, you might have access to a Monthly Reporting task pane that details the steps you need to
do to run your monthly reports, and links to those reports. You wouldn't necessarily need this task pane
to be open at all times; instead, you would only want to see it when you are ready to process your
monthly reports. You could open the task pane as needed from the Task Panes Library or from another
custom task pane that links to it.

� Closing task panes
Most task panes cannot bemanually closed. Either they are global task panes that always apply, or they
are context-sensitive task panes that close automatically when the associated file or feature is closed.
Alternatively, you can minimize the Axiom Assistant area to "hide" all task panes and gain more screen
space for your open files.
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If a task pane is closeable, then you can close it by clicking the X icon on the side-tab for the task pane. If
this icon is not present, then the task pane cannot be closed. Typically, only task panes that you open
manually can be closed manually, but in some cases you may also be able to close task panes that open
on startup.

� Using task panes in the Axiom Excel Client
When using the Axiom Excel Client, each file opens within its own window, and each windowmaintains its
own set of ribbon tabs and task panes. This means that as you switch windows, the set of task panes
available in each windowmay be different. For example:

l If you manually opened a task pane in one window, that task pane will only be present in that
window. It will not be present in other windows.

l The currently active task pane is managed independently for each window, so the active task pane
may change as you change windows. (This can also occur when using the AxiomWindows Client, if
you switch between files that have different default task pane associations. However, in the Axiom
Excel Client it may also happen when switching between files with the same default task pane
associations.)

l The current state of task panes is managed independently for each window. For example, if you
expand the Reports Library in the Explorer task pane in one window, that expansion will not be
present if you switch to a different window.

Viewing notifications using the Notifications task pane
If you receive an Axiom Software notification, the notification displays in the Notifications task pane. This
is a system-controlled task pane that is always available if you have notifications. Click theNotifications
tab in the Axiom Assistant area to view the task pane.
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Example Notifications task pane

If you have unread notifications when you first log in, or if you receive new notifications during a current
session, the Notifications tab will flash orange and remain that color until you click on the tab. Unread
notifications display in bold text. Once a notification has been read, the bolding is removed.

Notifications can come from the following sources:
l Alert notifications. Your system administrators and other power users may have set up alerts to

monitor certain alertable conditions and then notify specified users.

l Process management notifications. These notifications result from active processes in process
management, such as to inform you that you have a new task in the process.

l Message stream notifications. If you have subscribed to a document's message stream, you will
be notified of any new comments made about that document.

l Axiom system processes such as Process Plan Files. If you have triggered certain system
processes, Axiom Software will notify you when the process is completed or when errors occur.
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NOTES:
l The Notifications task pane is a system-controlled task pane; you cannot hide or show this

task panemanually. The Notifications task pane always displays on startup if you have any
active notifications (read or unread). Otherwise, it does not display. If you receive a new
notification during a session and the task pane is not already open, this will cause the task
pane to open.

l All notifications displayed in the Notifications task pane are also available in the Notifications
panel of the AxiomWeb Client. Both areas read from the same source of notifications, and edit
the same source as well. So if you mark a notification as read in one area, or delete a
notification from one area, the other area will reflect these changes.

� Reviewing notifications
Within the task pane, notifications are listed in the order they were created, with the newest notifications
at the top. Each notification displays a severity icon and an alert title, as well as how old the notification
is. The following severity icons are used:

l Info

l Warning

l Error

To read the notification text, double-click the notification to expand it. The text should provide you with
more information about the notification and why you are receiving it. You can double-click the
notification again to collapse it.

If the notification is from an alert, then the alert creator may have specified a document that you can
open to seemore information about the alert condition. If so, then you will see an Open link underneath
themessage text when you expand the notification. Click this link to open the associated document.

� Notification actions
You can select one or more notifications and then right-click to perform the following additional actions: 

l Mark Read: Mark the selected notifications as read.
l Mark Unread: Mark the selected notifications as unread.
l GoTo Alert Definition: Open the source document for the alert, if you have permission to access

the file. You will be taken directly to the specific alert definition that generated the notification.
l Delete: Delete the selected notifications. Keep in mind that once a notification has been deleted,

you cannot undo this action.
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Exploring files using the Explorer task pane
Using the Explorer task pane, you can quickly access your favorites, recent items, and all Axiom files (and
other assets) that you have rights to access.

The Explorer task pane is a streamlined version of the Axiom Explorer dialog. Most files and features
available in Axiom Explorer are also available in the task pane, dependent on your security permissions.

The Explorer task pane is available in the Axiom Assistant area. To view the Explorer task pane, click the
Explorer tab along the left-hand side of the Axiom Assistant area.

NOTE: The Explorer task pane is provided by default, but it may be disabled in your system, or
restricted to only certain users, or customized. If you are an administrator and you want to configure
the availability of the Explorer task pane, see the System Administration Guide.

The Explorer task pane is organized into sections. You can collapse and expand each section by clicking
on the arrow button in the right-hand side of the section header.

Explorer Section Description

My Files Contains the following:
l Favorites: Your personal list of favorites. For more information on saving

and managing favorites, seeManaging favorites.
l Recent: A list of your recently-opened items. This list displays the last 15

items that you opened. If desired, you can clear the list by right-clicking
Recent and selecting Clear History.

l My Documents: A "personal" folder within the Axiom Software file system
where you can save documents. Only administrators and users with the
User Documents Folder Access security permission have access to this
feature.

NOTE: If a red arrow icon displays next to an item in Favorites or Recent, this
means that the item the shortcut points to has been subsequently deleted.
Moving or renaming an item does not break a shortcut, since files are tracked
using the document ID.

File Groups Contains the file groups that you have access to.

End users can open plan files from this area. Administrators and other users
with special feature permissions can manage file groups from this area.

By default, file groups display in categories. If you are not using categories, or
if you just want to change the view to display by file groups, you can do this
by right-clicking the File Groups header.
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Explorer Section Description

Libraries Contains the Axiom libraries and files that you have access to. You may have
access to one or more of the following: Reports Library, Table Library, Data
Diagrams Library, Filter Library, Task Panes Library, Ribbon Tabs Library,
Process Definition Library, Scheduler Jobs Library, Imports Library, and
Exports Library.

Most end users only have access to the Reports Library.

Axiom System Contains Axiom system files. Only administrators have access to this area.

Viewing and completing process tasks using the Process task pane
The Process Management feature can be used to manage and track any Axiom-related process. A
process is a series of defined steps that represent the tasks to be completed. If you are the assigned
owner of a step in a process, then it is your responsibility to perform the necessary task and mark the
step as complete by the specified due date. You can do this by using the Process task pane.

The Process task pane displays automatically when you are the owner of an active step in a process. The
task pane displays one or more processes in which you have active tasks. The process summary displays
the process name and the number of active tasks you have in the process.

NOTE: The Process task pane is available by default, but may be disabled or customized in your
system. If you are an administrator and you want to configure the availability of the Process task
pane, see the System Administration Guide.

To view your active tasks in a process, click the arrow button on the left-hand side to expand the process
(or double-click the process summary). Your active task(s) are listed underneath. For each task you can
see the step name, the due date, and any additional details about the step. The following screenshot
shows an example Process task pane with an active task:

User Guide Axiom Software │ 15



Using the Process task pane, you can do the following:
l Open associated files and features: Some tasks may have a link to an associated file or feature, to

help you perform the task. Other tasks do not have these links. If no link is present, then you will
need to manually navigate to any file or feature needed to perform the task.

l Complete the step: When you have finished your task, you must mark the step as complete. In
most cases you do this by clickingMark step as complete.

However, there is also a special type of step known as an "approval step." In this case you must
indicate whether you approve the process to continue by clicking either Approve or Reject.
Approvemeans that the process will move to the next step, and Reject means that the process
will return to a prior step.

l View the entire process: By default, only your active step is shown in the task pane. In some
cases, you may have the option to view all steps in the process, so that you can see how your
active step relates to the overall process. If this option is present in the task pane, then click Show
process view to see all steps in the process, including previously completed steps and steps to be
performed in the future. This view is for information only; you cannot complete steps in Process
View. To return to Task View, click Show task view. Process View is only available to step owners if
the process has been configured to allow access to it.

� Step types
Each step listed in the Process task pane has an icon that indicates what type of step it is.

Icon Step Type Description

Approval This step requires you to approve the process to continue to the next
step, or reject the process to return it to a prior step.

Edit Plan File This step requires you to work on a plan file.

File Group This step requires you to perform a task on a file group.

Generic This step can require you to perform any kind of task.

Import This step requires you to perform a task on an import.

Multiple
Approvals

This step is a Multiple Approvals Step, which means that all the sub-
steps underneath it can be performed in any order instead of
sequentially. You may be responsible for one or more sub-steps of
the subprocess.

NOTE: This icon only displays in Process View, where you can see the
parent step as well as all sub-steps. Parent steps do not display in
Task View; only currently active sub-steps show.
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Icon Step Type Description

Parallel
Subprocess

This step is a Parallel Subprocess, which means that all the sub-steps
underneath it can be performed in any order instead of sequentially.
You may be responsible for one or more sub-steps of the subprocess.

NOTE: This icon only displays in Process View, where you can see the
parent step as well as all sub-steps. Parent steps do not display in
Task View; only currently active sub-steps show.

Report This step requires you to perform a task on a report.

Scheduler This step automatically runs a designated Scheduler job. The status
of the job displays in the task pane for your information only. Under
normal circumstances, you do not need to do anything to complete
this step, all job processing and step completion occurs
automatically.

Table This step requires you to perform a task on a table.

With the exception of the Scheduler step type, keep in mind that Axiom Software does not automate any
of the tasks. Although a file or featuremay be associated with a step, it is still up to you to use that file or
feature as necessary to perform the task. Other tasks may not be associated with any file or feature, and
it is up to you to perform the task as necessary.

If you are unclear what needs to be done to perform the task, make sure to review the step description
(in the step tooltip) and then contact your system administrator if you have any further questions.

� Completing steps
To complete a step, clickMark step as complete (or click Approve / Reject if the step is an approval
step). This opens the Process Action dialog.

The diagram at the top of the dialog shows the current step, the next step, and the previous step (when
rejecting only). If you are completing or approving the current step, the process will move forward to the
next step. If you are rejecting the current step, the process will move back to a prior step.

If desired, you can enter a comment into the Comment box. This comment will be saved in the process
history, and in most cases will also be included in the notification to the next step owner (if notifications
are enabled).
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NOTES:
l If the step you are completing is a child approval step of a multiple approvals step, then the

"next step" is the top-level step that comes after themultiple approvals step. However, there
may still be other active child approval steps that need to be completed before the process
moves to that next top-level step. If you approve the step and enter a comment, the
comment will be included in the notification to the next step owner once all of the child steps
are complete.

l If the step you are completing is part of a parallel subprocess, then only the current step
displays at the top of the dialog. This is because the parallel steps can be completed in any
order, and completing the current step will not necessarily move the process to the next step
(that will only happen when all of the parallel steps are complete). In this situation, any
comment entered is only saved in the process history, it is not included in an email to the next
step owner.

l If the step you are completing is a File Group step that involved cloning a file group, and the
new file group is referenced by subsequent steps, then you must specify the name of the file
group that was created as a result of the step. Axiom Software will attempt to guess the
correct file group; if the guess is not correct then you can use the drop-down list in the step
completion dialog to specify the correct file group. The dialog will only list clones of the target
file group for the step.

l If you are the assigned owner of a Scheduler Process Step, then by default you do not need to
do anything to complete the step—it will be completed automatically if the Scheduler job
processes without error. However, if the job experiences errors then you will have the options
to Restart scheduled job (assuming that the issue that caused the error has been resolved) or
toMark step as complete (assuming that the job does not need to be run again in order to
consider the step completed).

If the step you completed was your only active task, then the Process task pane will be empty for the
remainder of the current session, and will not open the next time you log in (unless you have been
assigned a new active task). The task pane will remain open if you have other active tasks in this process
or another process, or if you are an administrator. The Process task pane is available to administrators as
long as any processes are active.

� Completing steps for multiple plan files
If the process is a plan file process, then the steps in the process are performed for each individual plan
file in the file group. In this case, you may be responsible for completing the task for multiple plan files.

If you are responsible for multiple plan files, then those files are listed with check boxes in the Process
Action dialog. You can select one or more check boxes to complete the step for those plan files.
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� Administrator features
If you are an administrator, then by default the task pane shows all active processes for which you have
an active task, as well as all active processes for which you are the process owner. If desired, you also
have the option to change the view to show all active processes. At the top of the task pane, use the
Show all processes toggle to see all active processes. To go back to only viewing your processes, click
Show my processes only.
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Administrators and process owners can also perform the following actions in the task pane:
l Click View status to view the Process Status dialog for the process.
l Right-click a process and select Stop Process to stop the process.
l Toggle between Show process view and Show task view. However, if you do not currently have

any active tasks in the process, then you can only use Process View.

Viewing and completing workflow tasks using the Workflow task pane
TheWorkflow task pane displays in the Axiom Assistant area when you have any current workflow tasks.
You can use this pane to review all of your workflow tasks, open your assigned plan files, and complete
your currently assigned tasks.

NOTES:
l Workflow is a legacy feature that has been replaced by plan file processes in process management.

Instead of workflow tasks, you may have process tasks. For more information, see Viewing and
completing process tasks using the Process task pane.

l TheWorkflow task pane is provided by default in systems using workflow, but it can be disabled in
your system or restricted to only certain users. The visibility settings of the task pane can also be
adjusted—for example, so that it is always visible. If you are an administrator and you want to
disable or restrict access to theWorkflow task pane, or change the visibility settings, or include the
control in a separate custom task pane, see the System Administration Guide.

TheWorkflow task pane displays all of your current workflow tasks. If you have no current tasks, then
the list will be blank. In this case, theWorkflow task panemay not display at all, depending on how it is
configured for your organization.

The list is organized by workflow name in a treeview. The plan files that are currently assigned to you are
listed underneath the workflow name. The plan files may be listed directly underneath the workflow
name, or they may also be organized by a grouping (such as by region, VP, or manager). The due date for
each plan file is listed to the right of the plan file name. Plan files are sorted by their display name.
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Example Workflow task pane

Example Workflow task pane with grouping

To perform a workflow action on one or more plan files, select them in the list. You can select individual
plan files, or you can select multiple plan files by using the SHIFT or CTRL keys. You can also select a
grouping (if applicable) to perform the action on all plan files in the grouping. The following workflow
actions are available:

l Open: Open the selected plan files.
l Submit: Complete the workflow tasks for the selected plan files by submitting them to the next

stage in the workflow. This action applies if the plan files are in an edit stage.
l Approve: Complete the workflow tasks for the selected plan files by approving them to the next

stage in the workflow. This action applies if the plan files are in a review stage.
l Reject: Complete the workflow tasks for the selected plan files by rejecting them to the prior stage

in the workflow. This action applies if the plan files are in a review stage.

NOTE: If you select some plan files that are in an edit stage and others that are in a review stage, then
the workflow action is Submit, which means that any plan files in a review stage will be approved. If
you want to reject some plan files in the review stage, you will need to select those files separately.

The workflow data is current as of when Axiom Software was launched. To refresh the data, click the
refresh icon at the top of the pane.

Commenting on documents using the Message Stream task pane
When viewing a spreadsheet Axiom file within the Desktop Client, you can view comments that other
users havemade about the document and also make comments about the document. New comments
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are stored in themessage stream for that document, so that all other users who access the document
can see the comment. Additionally, you can "tag" other users in the comment, so that the tagged users
are notified about the comment.

You can view comments and add comments using theMessage Stream task pane. This is a system-
controlled task pane that automatically opens for eligible documents.

NOTES:
l Themessage stream is only available for documents where it has been enabled.

l Themessage stream is also available for Axiom forms, using theMessage Stream panel. This
panel is accessible from the task bar displayed across the top of the form.

� Viewing the message stream
To view themessage stream for the current document, click theMessage Stream tab to display the task
pane in the Axiom Assistant sidebar. This task pane shows all comments that have been made about the
document.

Example message stream

Comments are displayed in the order they weremade, with themost recent comment shown at the top
of the panel. Each comment shows when the comment was made and the user who made it.
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To view the full text and details of a comment, hover your cursor over the comment so that the > symbol
displays on the right-hand side of the comment. Click the symbol to open a separate Comment Details
dialog with the full comment text.

Once themessage stream has been loaded for the current document, it is only updated automatically
after you add a new comment. If necessary, you can manually refresh the task pane to see if any other
users havemade comments during the current file session.

Comments are stored for the life of the document, and cannot be deleted.

� Adding a comment
To add a comment, click Add Comment at the top of theMessage Stream task pane. In the Add
Comment dialog, you can define an optional title for the comment, and then define the comment text.
Basic text formatting of bold, italic, and underline can be used.

If desired, you can "tag" one or more users in the comment, so that those users are notified about the
comment. Any user tagged in the comment will receive an email that contains the content of the
comment and a link to the document. To tag a user, use the Tag user box to find a user and insert the
tag. You can type into the box to find a specific user, or select a user from the drop-down list. When you
click on a user name in the list, a tag will be inserted at the current cursor point in the comment text. The
tag displays as @FirstName LastName.

When you click Post, the comment is saved to themessage stream, and any tagged users will be notified.
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NOTES:
l All users with access to the document can see comments posted to themessage stream. Any

comments made should be appropriate for the entire document audience. Do not post any
sensitive information to themessage stream.

l Adding a comment automatically subscribes you to the document's message stream, and
tagging a user automatically subscribes that user to the document's message stream.

� Ongoing notifications (subscriptions)
If you havemade a comment in a document's message stream, or if you have been tagged in a
comment, you are now subscribed to that document's message stream. Whenever a new comment is
made to that document's message stream, you will receive a notification in the Notifications task
panepanel.

The notification details the user who made the comment and when it was made, the text of the
comment, and a link to open the file.

Currently it is not possible to unsubscribe from a document's message stream once you have been
subscribed.

Managing favorites
You can save Axiom files and other items as favorites, for quick access to commonly used items. Your
favorites list is available in the following locations:

l The Explorer task pane in the Axiom Assistant area
l The Axiom Explorer dialog (if you have permission to access this dialog)

When an item is saved to favorites, you can open the item by double-clicking it, or you can right-click it to
access any other commands that would be available on the item in its native area. For example, if you
have rights to the Table Library and you save a table as a favorite, you can right-click the table favorite
and perform actions such as editing the table structure.
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If an item that a favorite points to is deleted, then the favorite becomes invalid and a red arrow icon
displays next to it. If you attempt to open an invalid favorite, a message box informs you that the item
has been deleted, and asks whether you want to delete the favorite. If a file is moved or renamed within
the Axiom Software file system, but it retains the same document ID, then the shortcut will not be
broken.

� Saving and deleting favorites
You can save an item as a favorite in one of the following ways:

l In the Explorer task pane and the Axiom Explorer dialog, you can right-click an item and select
Add to Favorites.

l When a file is open, you can right-click the file tab and select Add to Favorites.

TIP: If you open a table using Open Table in Spreadsheet, and then save the open table as a favorite
(using the file tabs), the settings you used will be automatically saved as part of the favorite, in the
shortcut properties. You may want to rename the favorite to indicate the particular settings (for
example: GL2018 - Filtered for North Region).

NOTE: If a web-enabled file is saved as a favorite in the Desktop Client, that favorite will also display in
theWeb Client. This includes Axiom forms and web reports. All other types of favorites do not display
in theWeb Client.

To delete a favorite, right-click the item and then select Delete.

� Organizing favorites
You can create sub-folders in the Favorites area to organize favorites by folder. To create a new folder,
right-click Favorites and select New Folder.

By default, favorites are displayed in the order that they were added (new favorites are added to the
bottom of the list). You can drag and drop individual favorites to change the order. Sub-folders cannot
be reordered—they will always display in alphabetical order.

To rename a favorite, right-click the item and then select Rename. The name becomes editable, and you
can type a new name.

� Shortcut properties
You can edit the shortcut properties for a favorite. Right-click the favorite and select Shortcut Properties.
In this dialog, you can edit the shortcut name, change the shortcut target, and define certain shortcut
properties.

The available shortcut properties vary by file type. For example, you can configure a report favorite to
always open as read-only, or to automatically apply a Quick Filter when opening.
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� Using web favorites in the Desktop Client
If you save a favorite in theWeb Client, that favorite also displays in the Desktop Client favorites list. You
can double-click the web favorite to open it in theWeb Client browser.

When a favorite is saved in theWeb Client, it is stored as a URL instead of a document shortcut. If the
target of the favorite is later deleted, the favorite does not show as invalid in the Desktop Client. If you
try to use the favorite, you are informed that the document or page cannot be found. In this case you
must manually delete the favorite.

Opening recent files
Axiom Softwaremaintains a list of your recently opened files. You can use this list for quick access to
recent files.

The recent file list is located in theMy Files section of the Explorer task pane and Axiom Explorer. You can
double-click files to open them, or right-click to access the context menu for the file type.

The list displays the last 15 files that you recently opened. Note the following:
l If you want to clear the list, right-click Recent and select Clear History.
l If you want to continue to have quick access to a recent file, you can add it to your favorites.

Right-click the file and select Add to favorites.
l If the icon next to a file name is a red arrow, this means that the file has been moved or deleted

since you accessed it, so it can no longer be opened from the recent file list.

In the AxiomWindows Client only, recent files can also be accessed from the Filemenu. In the Axiom
Excel Client, although your recent files are tracked in File > Recent, those links point to the temporary
versions of the file stored on your local drive, not the source versions of the files stored in the Axiom
Software database. Therefore, Excel's recent file list cannot be used to open Axiom files.

Using spreadsheet features
All Axiom spreadsheet files—plan files, reports, templates, and drivers—areMicrosoft Excel
spreadsheets. In addition to Axiom Software features, you can use spreadsheet features for formatting,
formulas, and other functions.

NOTE: Your organization may choose to deploy certain files as web-enabled Axiom forms instead of
as spreadsheets. In this case you will interact with the file as if it were a web page, and spreadsheet
features will not be available.
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� Using spreadsheet features in the Excel Client
When you work on Axiom files in the Axiom Software Excel Client, all of the features ofMicrosoft Excel are
available to you. You can use standard Excel features to format cells, create charts and graphs, create
formulas, etc.

Where appropriate, standard Excel menus and shortcuts can be used to perform their equivalent Axiom
Software function. For example, if you want to save an Axiom file, you can click Save on the Axiom tab of
the ribbon, or you can use the Excel menu Save command (or Excel's keyboard shortcut of CTRL+S).
However, note that you cannot use Excel's fileOpen command to open files that are stored in the Axiom
Software database—managed Axiom files must be opened using Axiom menu commands.

While you are working in the Excel Client, you can open "regular" Excel spreadsheets and work with them
as normal alongside any Axiom files that you have open. You do not need to open another Excel session
or close your Axiom Software session in order to work with regular Excel files.

� Using spreadsheet features in the Windows Client
The Axiom SoftwareWindows Client emulates theMicrosoft Excel spreadsheet environment. While the
spreadsheet itself and the Axiom file features are essentially the same in either client, the way that you
work with spreadsheet features is different in theWindows Client.

In theWindows Client, you access spreadsheet features from the following locations:
l File menu: Similar to the File menu in Excel, this menu provides access to basic commands such as

Open, Close, Print, and Save.

l Home tab: Similar to the Home tab in Excel, this tab contains some common spreadsheet
formatting commands such as copy and paste, font and number formatting, and other cell and
sheet formatting options.

l Range Explorer: Using the Range Explorer, you can format cells and define cell-related features
such as validation and conditional formatting. Available from the Axiom Button and the right-click
menu.

l Workbook Explorer: Using theWorkbook Explorer, you can add and delete sheets, and work with
sheet-level settings. You can also define named ranges. Available from the Axiom Button and the
right-click menu.

l Display: In theDisplay group on the Axiom tab, you can toggle the formula bar and row / column
headings on and off.

For example, the following table details some common spreadsheet actions and how to perform them in
theWindows Client:

Action Windows Client

Open an external
spreadsheet file

From the Filemenu, click Open.
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Action Windows Client

Change the name of a
sheet

On theHome tab, in the Cells group, click Format > Rename Sheet.

Add a sheet to a file On theHome tab, in the Cells group, click Insert > Insert Sheet.

Set rowwidth or
column height

On theHome tab, in the Cells group, click Format > Row Height or Format
> Column Width.

Hide or unhide a
sheet

On theHome tab, in the Cells group, click Format > Hide & Unhide.

Changing your Axiom Software password
If your authentication method is Axiom Prompt, you can change your password as needed. This feature
does not apply to users who are using any other authentication method (such as Windows User
Authentication), because those passwords are controlled externally from Axiom Software.

To change your password:
1. On the Axiom tab, in theHelp group, click Help > Change Password.

NOTE: In systems with installed products, this featuremay be located on theMain or Admin
tab.

This command is only available to Axiom Prompt users.

2. In the Set Password dialog, enter your current password, then enter and confirm your new
password.

If password rules are being enforced, your password must meet the rules. A validation message
will inform you of the rules if necessary. Alternatively you can click Generate Password to auto-
generate a password that meets the rules. If you do this, make sure to note the generated
password because you will not have another opportunity to see it. If you do not note the
password and cannot log in later, an administrator will need to reset your password.

3. Click OK.

Your password is now changed. You will need to use this new password the next time that you log in.

Closing Axiom files
You can close an Axiom file in one of the following ways:

l Click the X in the right-hand side of the file tab.
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l Right-click the file tab and select Close or Close All. Note that using Close All will not close the
Home file.

l Click File > Close.
l Click the lower X in the right-hand side of the application window (Excel Client only).

If the file has any unsaved changes, you will be prompted to save the file before it is closed.

If you are using the Excel Client, and you close all open files, then the application will automatically close.
In theWindows Client, the application will remain open with a blank file area.

If close options are not available for a particular file, such as the Home file, that means the file has been
designated as "non-closeable" by a system administrator. This file is intended to always remain open
while you are in Axiom Software.

� Closing multiple files
When using Close All or Close All But This, or when closing the application with open files, Axiom
Software checks all files for unsaved changes before closing. If any are found, the Save Modified Items
dialog opens, listing each file with unsaved changes.

By default, all modified read/write files are selected to save before closing. If you do not want to save a
particular file, clear the check box for that file. You can also use the Select All and Clear All options.

If you choose to save files as part of the close, this will perform a full save (both saving the file and
performing a save-to-database if applicable).

Closing Axiom Software
To close Axiom Software, click the Close Axiom Software button in the Exit group of the Axiom tab. (In
systems with installed products, this button may be located on theMain or Admin tab.) You can also
close the application by clicking the X button in the top right-hand corner of the window. You will be
prompted to save any changed but unsaved files.

If you are using the Axiom Excel Client, there is no way to close Axiom Software and leaveMicrosoft Excel
open. If you want to work with an Excel file, you can open the file within Axiom Software, or you can open
a second Excel session.
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Using Plan Files
Plan files are used to develop planning data and save that data to the database. This section explains the
basic concepts behind plan files and how to use them.

This section is intended for end users working with existing plan files, to develop and review plans. If you
have rights to administer file groups and their components, see the File Group Administration Guide and
the Axiom File Setup Guide.

In addition to the plan-specific functionality detailed in this section, you can use standard Axiom file
features and tools. Plan files use the same functionality as other Axiom files to perform actions such as
changing views or navigating to file bookmarks. For more information, see Using Axiom File Features.

About plan files
Using plan files, you can develop planning data for your responsibility areas and save that data to the
database.

Example data flow for planning data

Each plan file is created as a copy of an assigned template. Once the plan file is created, it is populated
with data and calculations that are unique to the particular plan code. Depending on the design of the
plan file, you can then perform activities such as inputting data, adding comments, and inserting new
rows as needed. When you save, data from the plan file is saved to the appropriate tables in the
database, where the data can then be used in reports.

3
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Plan files are associated with a file group, which is a set of files supporting a specific planning effort. You
may have access to multiple file groups.

Your organization may use file groups to managemultiple planning processes (for example, a "Budget"
file group and a "Forecast" file group), and/or each file group may represent a specific planning cycle (for
example, the "2018 Budget" file group). If you have any questions regarding the purpose of each file
group, please contact your system administrator.

Typically, there is a plan file for each plan code within the designated planning dimension for the file
group. For example, budgets are typically done at a department level, but forecasts are often done at a
divisional or regional level. The Budget file group would have a plan file for each department, and the
Forecast file group would have a plan file for each division. However, planning can be performed at any
level.

� Plan file structure
Plan files may be spreadsheet-based or browser-based:

l Spreadsheet-based plan files areMicrosoft Excel spreadsheets that aremanaged and enhanced by
Axiom Software. You can use spreadsheet features within the plan file, within the limits of the
sheet protections applied to the plan file. Plan files can havemultiple sheets. For example, a plan
file might have an Instructions sheet, a Budget sheet, and a Payroll sheet.

l Browser-based plan files are interactive web pages designed to meet a particular planning need.
You can access these plan files within the AxiomWindows Client or within your web browser.
These plan files are typically organized into multiple tabs, so that you can move between different
areas of the plan file by clicking the tabs. Browser-based plan files are created by using a special
type of Axiom file called an Axiom form.

Plan files are designed to meet your organization's particular planning needs, and vary from system to
system. If you have any questions about the contents of a plan file, contact your system administrator.

For themost part, the information in this guide assumes that you are using spreadsheet-based plan files
within the Axiom Excel Client or the AxiomWindows Client. Spreadsheet-based plan files use a standard
set of features to perform actions such as inserting new rows, changing views, and navigating to different
areas of the plan file. Browser-based plan files support greater customization of the user interface, so
that the way in which users interact with the plan file can differ greatly depending on the file design.

� Calc method libraries
Each sheet in your plan file may have access to a calc method library. Calc method libraries contain sets
of predefined rows that define the formatting and calculations for rows in your plan. You can use these
calc method libraries to insert new rows into your plan, or to change the calculations used on existing
rows of your plan. See Adding or changing rows in a plan file.
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� Plan file access
You have been granted rights to access certain file groups and certain plan files within those file groups.
You can open those plan files according to the level of access you have been assigned in Security (for
example, read-only or read/write).

Plan files can also be part of a plan file process (or in older systems, a workflow). In this case the planning
cycle has a defined set of steps, and each plan file has a designated owner for each step. If you are
assigned as an owner, this means it is your responsibility to complete the current "task" in the process.
This may mean editing the plan file or reviewing it, depending on the current step. Axiom Softwaremay
"elevate" your access rights to the plan file as necessary so that you can complete this task. For example,
if you normally have read-only access to plan files, but you are the assigned owner of a plan file in an edit
step, then you will be temporarily granted edit rights so that you can complete the task.

Opening a plan file
Plan files are accessed from the File Groups group on the Axiom tab, or in the Explorer task pane. Your
security settings determine what file groups you have access to, and which plan files you can access
within the file group. Your access rights to each plan file (read-only or read/write) are determined by a
combination of your security settings and whether you are the current owner of the plan file in an active
plan file process or a workflow.

NOTE: The names of the file groups and how they are presented to you is determined by your
organization. Although the default presentation is on the File Groups group of the Axiom tab, your
organization may decide to customize the group name or location, or present file groups in a custom
ribbon tab or task pane. Plan files may also be accessible via the Process task pane or theWorkflow
task pane. Contact your system administrator if you have any questions about how to access your
plan files.

To open a plan file:
1. On the Axiom tab, in the File Groups group, click the name of the file group that you want to

work with. The following screenshot shows some example file group buttons:
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If you have access to any file group administration features, then clicking on the file group button
will bring up a menu with your options. In this case, you must click Open Plan Files in order to
open a plan file. If you do not have access to any file group administration features, then clicking
on the file group button automatically launches the Open Plan Files dialog.

File groups can be organized into categories. In that case, click the category name to open a sub-
menu with the list of file groups in the category, and then click the desired file group name.

2. In theOpen Plan Files dialog, select the file or files that you want to open, and then click OK.

This dialog lists all plan files available to you based on your Security settings. If you have
previously opened a plan file within this session, that plan file will be selected by default when you
enter the dialog (unless the dialog displays plan files in groupings, in which case previous
selections are not retained).

The search box at the top of the dialog can be used to quickly find a particular plan file. The file
group administrator determines which plan file properties are included in this search, but by
default the plan code and description are searchable. You can also sort and filter the list using
standard Axiom grid functionality.

TIP: If you have read/write permissions to a file but you want to open it as read-only to
prevent locking the file from other users, right-click your selection and then select Open Read
Only.

If the dialog is empty, then either you do not have access to any plan files in the file group, or the
plan files have not yet been created for the plan codes that you have rights to.

The selected plan files open. If a file was opened read-only, then the text (R/O) displays in the file tab.
Read-only plan files cannot be saved.

NOTE: If another user has the plan file open with read/write permissions, then the file will be opened
as read-only, regardless of your security permissions.

If the plan file is form-enabled, it opens as a web form within the current client. When using Axiom forms,
the form is always opened as read-only, and any save processes are for saving data to the database only.
The functionality available in an Axiom form is solely dependent on how the form is configured; if you
have any questions about the use and features of a web-enabled form, contact your system
administrator.

Advanced options
The following advanced options in this dialog are generally only available to administrators:

l If you want to open a plan file without refreshing Axiom queries that are configured to refresh on
open, right-click the file and then select Open Without Refresh. Generally, you should only do this
if you are opening the file for troubleshooting purposes or to edit its configuration only.
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l If no plan files have been created for this file group, and you have rights to create plan files, then a
link appears in the blank plan file list: Create Plan Files for File Group. You can click this link to
open the Create Plan Files dialog.

l If you want to see plan codes that do not yet have a plan file, select Show Plan Files that have
not been created. This is for reference only; you cannot create individual plan files from this
dialog.

l If the plan file is form-enabled and you want to open it as the source spreadsheet file instead of as
the web form, select Open as Spreadsheet. This option is available to all users.

Creating a plan file
Some file groups may be set up so that users can create plan files on demand. Typically this configuration
is used for planning processes where the list of projects or initiatives to be planned for is not known in
advance, such as capital project planning or strategic planning. Instead of planning based on a
predefined list of items (such as budgeting based on departments), users can create plan files as they are
needed.

NOTE: The ability to create a plan file "on demand" is only available if the file group meets certain
requirements and the feature has been enabled in the file group properties. For more information on
using this feature with a file group, see the File Group Administration Guide. For other file groups,
end users do not create plan files; instead, an administrator creates the plan files using the Create
Plan Files utility.

To create a plan file on demand:
1. On the Axiom tab, in the File Group group, click the button for the file group where you want to

create a new plan file.

TheOpen Plan Files dialog opens.

2. To create the plan file, you can create it based on the plan file template, or you can clone an
existing plan file. Use the commands in the top right-hand corner of the dialog, above the list of
existing plan files:

l To create a new plan file based on the template, click the plus icon .

The name of this command is configurable for the file group. For example, the command
may say "Create plan file," or "Create new project," or "Add strategic initiative."

l To clone an existing plan file to create a new plan file, select the plan file that you want to
clone, and then click Clone selected item.
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These commands are not available for file groups where the on-demand feature has not been
enabled.

3. Before the plan file is created, you may be prompted to select certain values relating to your new
plan file, such as specifying a department. Complete the inputs as appropriate and then click OK.

The new plan file is created, and opens in Axiom Software. You can now complete any necessary inputs
and changes, and then click Save to save it.

If you cloned an existing plan file, any inputs in the existing plan file are also included in the new file. You
may need to change these entries as appropriate for the new file.

NOTES:
l If you do not have the necessary security permissions to create new plan files in an on-

demand file group, then the options to "create new" or "clone existing" do not display in the
dialog.

l The "clone existing" feature can be disabled at the file group level; in which case the option
does not display in the dialog.

Editing a plan file
When you open a plan file, the level of edit rights depends on the combination of your security settings
and whether you are the current owner of the plan file in an active plan file process or a workflow. For
example, you may normally have read-only access to the plan file, but when you are the step owner for
an Edit Plan File task in a plan file process, you are temporarily granted read/write access.

If you have edit rights to a plan file, note the following:
l Plan files are typically designed so that editable cells are shaded or otherwisemarked as available

for edit. If a cell is editable, you can input values directly, or use Excel formulas to result in a value.
All other areas of the sheet are typically protected and cannot be changed.

l Some cells may use Data Validation to present a list of choices. In this case you can use the drop-
down list to select your desired choice.
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l Depending on your security rights, you may be able to add new rows to the plan, or change the
calculations used on existing rows. For more information, see Adding or changing rows in a plan
file.

l If your plan files support it, you may be able to double-click on a row of the plan to bring up an
input form for that row. The input form contains key settings for the row that you can change.

Plan file design is completely flexible and is set up to meet the needs of your organization. If you have
any questions about the design of your plan files, contact your Axiom Software system administrator.

When you have finished making edits to the plan file, you can click Save to save the changes and to save
your data to the database. For more information, see Saving a plan file.

Adding or changing rows in a plan file
Calc method libraries store sets of predefined calculation methods that define the formatting and
formulas for rows in your plan file. You can use calc methods to:

l Add a new row (or rows) to your plan.

When plan files are created, they may only be populated with accounts that have historical data.
You may need to use calc methods to add an account to your plan if you did not plan for that
account last year. You can also use calc methods to add new items to your plan, such as new
employees or new capital items.

l Change the calculations used in an existing row in your plan.

Using the calc method "change" option, you can change the calculations used on existing rows of
your plan by applying a different calc method to that row. For example, imagine that the default
calculation for an account is to spread a total amount evenly across months, but for your plan
code it would bemore appropriate to use a monthly statistic to spread the total.

Calc methods can be used even when the sheet is protected.

Adding rows to a plan file
You can insert new rows into your plan file using calc methods. A calc method is a predefined row (or
rows) that defines the formatting and formulas to be applied to a row. For example, you may need to:

l Add an account that is not currently in the plan file
l Add a new employee
l Add additional detail lines, if you are planning for certain accounts at the detail level

After a calc method is inserted, you need to complete the new row(s) with the appropriate information.
For example, you may need to enter an account number, or input plan values. The calc method may use
a form to help you complete some of these inputs.
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You can only insert calc methods if you have the appropriate security permissions. The ability to insert
calc methods is controlled on a per file group basis, using the Allow Calc Method Insert permission.
Additionally, administrators and users with theManage Calc Methods permission can always insert calc
methods.

Additionally, most plan files are set up to use calc method controls. If you have the necessary security
permissions to insert calc methods, then these controls further specify where calc methods can be
inserted, and which calc methods can be used at each location.

There are several different ways to add a new row to a plan file. Themethods available to you depend on
how your plan files have been set up by your administrator:

l You can use custom insertion points to automatically add new rows to the appropriate locations
throughout the plan file.

l You can double-click on designated rows within a sheet to add new rows at that location.
l If the plan file does not use either of the abovemethods, or if you are a calc method administrator

who can add rows anywhere in the file, then you can add new rows manually.

� Adding a row using a custom insertion point
Plan files may be set up with custom insertion points. These points are intended to guide you to the
appropriate places to add new rows to a plan file. Custom insertion points are available on the Add Row
(s) > Custom Insertsmenu.

There are two different types of custom insertion points: dynamic and static. Plan files may use only
dynamic insertion points, only static insertion points, or a combination of both.

l When using a dynamic insertion point, you select the item that you want to add to the plan file
(such as an account), and then the insertion controls dynamically determine where the account
should be added. If the account already exists in the file, you are taken to the relevant row.

l When using a static insertion point, you select from one or more specific areas in the plan file that
are enabled for insertion, and then add the new row in that selected location.

The Custom Inserts menu shows all insertion points defined within the file (not just for the active sheet).
When you select an insertion point, you may be taken to another sheet in the file.

The Custom Inserts menu is only available if you have the appropriate security permissions to insert calc
methods.

To insert new rows using a custom insertion point:
1. On the Axiom tab, in the File Options group, click Add Row(s). Then, select the desired insertion

point from the Custom Insertsmenu.

TIP: You can also access this menu by right-clicking anywhere in a plan file (Calc Methods >
Custom Insert).
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Dynamic insertion points are single items on themenu. For example, theremight be a dynamic
insertion point named Update an account:

Static insertion points are organized into sub-menus. For example, theremight be sub-menu
named Add a new employee, which contains two insertion points: Hourly and Salary.

2. The next step depends on whether you have selected a dynamic insertion point or a static
insertion point:

l If you have selected a dynamic insertion point, the Choose Value dialog opens. Select the
desired item that you want to add to the plan file, and then click OK. For example, the
dialog may display a list of accounts, in which case you would select the account that you
want to add.

If the selected item already exists in the relevant sheet and no further calc methods can be
inserted for it, then you are simply taken to the location of the existing item. The dynamic
insertion process is now complete. Otherwise, the dynamic insertion process determines
where the selected item can be added, and moves your cursor to that location.

l If you have selected a static insertion point, your cursor is moved to the location that
corresponds with the selected insertion point.

3. One of the following occurs, depending on whether multiple calc methods are eligible to be
inserted at this location:

l Multiple calc methods: If more than one calc method can be inserted at this location, then
the Insert Calc Method dialog opens. Select the calc method that you want to insert, and
then click OK.
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Example Insert Calc Method dialog

The available calc methods are listed in the left-hand side of the dialog. When you select a
calc method name, the properties of that calc method display in the right-hand side of the
dialog, including a description. If you are not sure which calc method to use, the
descriptions may provide guidance.

If you want to insert multiple instances of the calc method, edit theNumber of items to
insert. By default, this is set to 1. For example, you may need to add two new employees to
a payroll budget, and both employees use the same calc method. In this case you can set
Number of items to insert to 2. The number of items that you can insert at any one time
may be limited to a certain maximum amount.

NOTE: The calc methods in this list are always limited to the calc methods allowed at
this location. If you are an administrator or a user with theManage Calc Methods
permission, and you want to insert a different calc method at this location, you must
insert it manually.

l Single calc method: If only one calc method can be inserted at this location, then that calc
method is selected automatically, and the Insert Calc Method dialog does not display.

If this location is configured to allow you to insert multiple instances of the calc method,
then you are prompted to specify the number of items to insert. Enter the number of items
(up to the specified maximum) and then click OK.
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4. If the selected calc method has defined variables, then the Calc Method Variables dialog displays.
Enter values for the variables, and then click OK.

The values that you enter for the variables will be placed in the appropriate cells when the calc
method is inserted into the sheet.

This dialog only applies if the calc method has defined variables. Otherwise, this dialog does not
display and the calc method is simply inserted into the sheet.

NOTES:
l If your plan files have been configured to support double-click forms, you can open this

form again later by double-clicking the calc method in the sheet. You can then change
any entries as needed. Keep in mind that some variables may be set up so that they
only display when inserting, such as the variable for selecting an account.

l If you are inserting multiple instances of the calc method, the selected values will be
repeated in each inserted calc method. Most likely you will need to edit the calc
methods after they are inserted to select unique values for each item.

After the calc method is inserted into the sheet, you may have inputs to complete. For example, you may
need to input an annual total to be spread equally across months or according to a statistic.

� Adding a row by double-clicking
Plan files can be set up to allow adding new rows by double-clicking in designated locations. These
locations will be designated in the sheet using text such as: "Add new row here" or "Double-click to add a
new account." The specific text used and how it appears depends on your particular implementation.
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Example plan file with a double-click "hotspot" for adding rows

To add a new row by double-clicking:
1. Double-click on the cell which contains the insertion text.

2. One of the following occurs, depending on whether more than one calc method can be inserted at
this location:

l Multiple calc methods: If more than one calc method can be inserted at this location, then
the Insert Calc Method dialog opens. Select the calc method that you want to insert, and
then click OK.
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Example Insert Calc Method dialog

The available calc methods are listed in the left-hand side of the dialog. When you select a
calc method name, the properties of that calc method display in the right-hand side of the
dialog, including a description. If you are not sure which calc method to use, the
descriptions may provide guidance.

If you want to insert multiple instances of the calc method, edit theNumber of items to
insert. By default, this is set to 1. For example, you may need to add two new employees to
a payroll budget, and both employees use the same calc method. In this case you can set
Number of items to insert to 2. The number of items that you can insert at any one time
may be limited to a certain maximum amount.

NOTE: The calc methods in this list are always limited to the calc methods allowed at
this location. If you are an administrator or a user with theManage Calc Methods
permission, and you want to insert a different calc method at this location, you must
insert it manually using the Add Row(s)menu.

l Single calc method: If only one calc method can be inserted at this location, then that calc
method is selected automatically, and the Insert Calc Method dialog does not display.

If this location is configured to allow you to insert multiple instances of the calc method,
then you are prompted to specify the number of items to insert. Enter the number of items
(up to the specified maximum) and then click OK.
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3. If the selected calc method has defined variables, then the Calc Method Variables dialog displays.
Enter values for the variables, and then click OK.

The values that you enter for the variables will be placed in the appropriate cells when the calc
method is inserted into the sheet.

For example, the calc method may have a variable for Account. The account that you select in this
dialog will be placed in the account column when the calc method is inserted into the sheet.

This dialog only applies if the calc method has defined variables. Otherwise, this dialog does not
display and the calc method is simply inserted into the sheet.

NOTES:
l If your plan files have been configured to support double-click forms, you can open this

form again later by double-clicking the calc method in the sheet. You can then change
any entries as needed. Keep in mind that some variables may be set up so that they
only display when inserting, such as the variable for selecting an account.

l If you are inserting multiple instances of the calc method, the selected values will be
repeated in each inserted calc method. Most likely you will need to edit the calc
methods after they are inserted to select unique values for each item.

After the calc method is inserted into the sheet, you may have inputs to complete. For example, you may
need to input an annual total to be spread equally across months or according to a statistic.

� Adding a row manually
You can add new rows to a plan file manually by placing your cursor in the desired area of the sheet and
then using Add Row(s) > Insert Calc Method(s).

This command is only available if you have the appropriate security permissions to insert calc methods. If
you have the appropriate permissions, then the availability of the command further depends on the
usage of calc method controls in the sheet:

l If calc method controls are used in a sheet, then this option is only available for rows that are
enabled to allow calc method insertion. In almost all cases, these are the same rows that are set
up with custom insertion points, so it is easiest to use the custom inserts menu to be taken
directly to these enabled areas.
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l If calc method controls are not used in a sheet, then you can insert calc methods anywhere in the
sheet.

Also, if no calc methods have been defined for a sheet, then this command is not available because there
are no calc methods that can be inserted.

Administrators and users with theManage Calc Methods permission can insert calc methods manually
anywhere in the sheet, regardless of whether calc method controls are being used.

To insert a row manually:
1. Place your cursor in the row directly belowwhere you want the new calc method to be inserted.

NOTE: If you are inserting a calc method on a row that is set up with calc method controls, the
location of the insert may be determined by the controls. By default, calc methods are
inserted above the current row, but the calc method controls may be configured to insert
below the current row.

2. On the Axiom tab, in the File Options group, click Add Row(s) > Insert Calc Method(s).

If this menu item is not available, then one of the following circumstances applies:

l No calc methods have been defined for the current sheet.
l Calc method controls are being used, and the current row is not enabled for insertion.
l You do not have security permissions to insert calc methods.

3. In the Insert Calc Method dialog, select the calc method that you want to insert, and then click
OK.

The available calc methods are listed in the left-hand side of the dialog. When you select a calc
method name, the properties of that calc method display in the right-hand side of the dialog,
including a description. If you are not sure which calc method to use, the descriptions may
provide guidance.

If you want to insert multiple instances of the calc method, edit theNumber of items to insert. By
default, this is set to 1. For example, you may need to add two new employees to a payroll
budget, and both employees use the same calc method. In this case you can set Number of items
to insert to 2.
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NOTES:
l If calc method controls are being used, then the list of calc methods is limited to those

allowed by the insertion point. Calc method administrators always see all calc methods
when manually inserting a calc method.

l If the selected calc method uses variables, and you do not want to be prompted to
enter variable values, you can clear the Prompt for calc method variables check box.
This option only displays on the dialog if the selected calc method uses variables, and if
the user is an administrator or has theManage Calc Method permission.

4. If applicable, in the Calc Method Variables dialog, enter values for the calc method variables, and
then click OK.

If the calc method has variables, then the values you enter for the variables will be placed in the
appropriate cells when the calc method is inserted into the sheet.

For example, the calc method may have a variable for Account. The account that you select in this
dialog will be placed in the account column when the calc method is inserted into the sheet.

This dialog only applies if the calc method has defined variables. Otherwise, this dialog does not
display and the calc method is simply inserted into the sheet.

NOTE: If your plan files have been configured to support double-click forms, you can open this
form again later by double-clicking the calc method in the sheet. You can then change any
entries as needed. Keep in mind that some variables may be set up so that they only display
when inserting, such as the variable for selecting an account.

After the calc method is inserted into the sheet, you may have inputs to complete. For example, you may
need to input an annual total to be spread equally across months or according to a statistic.

Changing rows in a plan file
You can change the calculations used on an existing row in a plan file, by overwriting it with a new calc
method. You can also use the change feature on multiple-row calc methods.

For example, your plan may have a row that requires monthly entries to calculate an annual total, and
you want to change the calculation to instead require a single annual entry that is spread evenly across
months.

The change operation does not simply replace the existing row. Certain information in the rowmay be
retained, such as the account number and historical data, depending on how the new calc method has
been configured, and whether calc method forms are used. For information on how the change
operation replaces the existing row, see Change calc method rules.
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You can only change calc methods if you have the appropriate security permissions. The ability to change
calc methods is controlled on a per file group basis, using the Allow Calc Method Change permission.
Additionally, administrators and users with theManage Calc Methods permission can always change
calc methods.

Additionally, most plan files are set up to use calc method controls. These controls specify which rows
can be overwritten, and which calc methods can be used at each location.

To change a row in a plan file:
1. Place your cursor anywhere in the row (or rows) that you want to change by applying a new calc

method.

If the original calc method in the sheet is a multiple-row calc method, it does not matter where
you place your cursor, as long as it in within one of the rows of the calc method.

IMPORTANT: This procedure assumes that your system has enabled template validation. Use
of template validation allows Axiom Software to detect specific calc methods in the sheet,
based on system-generated codes. If your system is not using template validation, then you
must highlight all rows of themultiple-row calc method before you can change it. If you are
not sure whether your system uses template validation, please contact your system
administrator.

2. On the Axiom tab, in the File Options group, click Add Row(s) > Change Calc Method.

If calc method controls are used in the sheet, then this command is only available if the first row of
the selection is enabled for overwriting. If calc method controls are not used in the sheet, then
you can change any rows.

Administrators and users with theManage Calc Methods permission can always change calc
methods anywhere, regardless of calc method controls.

NOTE: If only one calc method is allowed for changing the row at this location, then themenu
command is changed to Replace with CalcMethodName. When you select this command,
the listed calc method is automatically used for the change operation, and the Change Calc
Method dialog does not open.

3. In the Change Calc Method dialog, select the calc method that you want to use to replace the
selected row or rows, and then click OK.

The available calc methods are listed in the left-hand side of the dialog. When you select a calc
method name, the properties of that calc method display in the right-hand side of the dialog,
including a description. If you are not sure which calc method to use, the descriptions may
provide guidance.
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NOTES:
l The list of calc methods is limited to the allowed calc methods for this location (if

applicable). If you are an administrator or a user with theManage Calc Methods
permission, then all calc methods are listed.

l If you have selected a calc method with a different number of rows than the original calc
method, Axiom Software informs you of the row difference and asks you to confirm
that you want to continue. The sheet will be adjusted accordingly for the additional or
fewer rows.

4. If applicable, in the Calc Method Variables dialog, enter values for the calc method variables, and
then click OK.

If the calc method has variables, then the values you enter for the variables will be inserted in the
appropriate cells when the calc method is placed into the sheet.

This dialog only applies if the calc method has defined variables. Otherwise, this dialog does not
display and the change operation continues.

Calc method variables are an exception to the normal calc method changing rules. If you enter a
value for a variable, that value is always placed into the sheet when the calc method is changed.
However, if you leave a variable value blank, then the normal change rules apply. Additionally,
some calc method variables are set up so that they are only displayed when the calc method is
inserted, such as a variable for selecting an account.

NOTE: If your plan files have been configured to support double-click forms, you can open this
form again later by double-clicking the calc method in the sheet. You can then change entries
as needed.

The selected calc method replaces the selected row or rows.

Multiple-row calc methods and changing rows
You can replace single-row calc methods with multiple-row calc methods, and vice versa. The change
operation intelligently deletes rows and inserts rows, depending on the row difference between the
original calc method and the new calc method.

l If the new calc method has fewer rows than the original calc method, the additional rows in the
sheet are deleted.

l If the new calc method has more rows than the original calc method, additional rows are inserted
into the sheet.

For example, if you want to replace a single-row calc method with a five-row calc method, place your
cursor in the rowwith the existing single-row calc method. The change operation replaces the single row
with the first row of the five-row calc method, and then inserts four new rows to accommodate the rest
of the five-row calc method.
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If you want to replace a five-row calc method with a three-row calc method, place your cursor anywhere
in the existing five-row calc method. The change operation replaces the first three rows of the five-row
calc method with the new calc method, and then deletes the extra two rows in the sheet.

IMPORTANT: This procedure assumes that your system has enabled template validation. Use of
template validation allows Axiom Software to detect specific calc methods in the sheet, based on
system-generated codes. If your system is not using template validation, then you must highlight all
rows of themultiple-row calc method before you can change it. In the previous example, you would
need to manually highlight all five rows of the calc method within the sheet before changing it,
because Axiom Software would be unable to automatically detect the starting and ending rows.

Change calc method rules
End users can replace an existing calc method in the sheet by applying a new calc method, thereby
changing the calculations used on the row (or rows).

The following replacement rules apply when using the Change Calc Method feature. When creating calc
methods, keep these rules in mind so that change operations will work as desired.

The change operation is evaluated on a cell by cell basis. Actions depend on what the new calc method
(the calc method replacing the existing calc method) contains in each cell.

If the new calc
method
contains:

The following action occurs:

A value or a
string

The value or string in the new calc method is ignored, and the existing cell value
is retained as follows:

l If the existing calc method contains a value, a string, or is blank, then the
existing cell contents are retained as is.

l If the existing calc method contains a formula, the value resulting from the
formula is retained by using Paste Special – Values. The formula is removed.

Formula The formula in the new calc method overrides the existing cell contents.

Empty cell The empty cell in the new calc method overrides the existing cell contents.

NOTE: The normal change rules do not apply to calc method variables. If the new calc method has a
variable defined, the variable value specified by the user always overrides the existing cell contents.
However, if the user does not specify a variable value (if the variable is not required and the user
leaves the entry blank, or if the variable is excluded from the change operation because it is set to
Insert Only), then the normal change rules apply to that cell.
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Adding sheets to an Axiom file
If your plan files, reports, or utilities have been designed to allow adding new sheets, then you can add
these sheets using the Add New Sheet feature. The new sheet will be created by copying a designated
master sheet, which serves as the sheet "template." If the file has multiple master sheets, you will be able
to choose themaster sheet to copy.

The Add New Sheet feature is only available if the file has one or more designated master sheets. These
master sheets must be set up and enabled by the file designer.

NOTE: If workbook protection is not applied to the file (or if you have permission to remove it), then
you can also add new sheets using normal spreadsheet features. However, if workbook protection is
applied to the file, then the Add New Sheet feature is the only way to add new sheets.

To add a new sheet to an Axiom file:
1. On the Axiom tab, in the File Options group, click Add New Sheet.

2. In the Add New Sheet dialog, complete the following:
l New sheet name: Type the name of the new sheet. This name cannot be the same as any

other sheet in the workbook, including themaster sheets. It is recommended to avoid
spaces and special characters in the name.

l Create from master sheet: Select themaster sheet to copy in order to create the new
sheet.

3. Click OK to create the new sheet.

The new sheet is placed in the workbook as follows:
l If the workbook already contains copies of the selected master sheet, then the new sheet is placed
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after (to the right of) themost recently added copy.
l If the workbook does not already contain a copy of the selected master sheet, then the new sheet

is placed after themaster sheet if it is visible. If themaster sheet is not visible, then the copy is
placed after the last visible sheet in the workbook.

NOTE: Added sheets cannot be printed using the Print Plan Files utility. If you need to print an
added sheet, you must do it by using Printwithin the file.

Viewing andmanaging file attachments for a plan file
Some file groups support the ability to attach supporting files to individual plan files. For example, in a
capital planning process, you may want to attach various supporting information about the capital
request, and have that information easily reviewable along with the plan file itself.

If you have read/write access to a plan file, then you can add and delete attachments as well as view
attachments. If you have read-only access to a plan file, then you can only view existing attachments.

To access the file attachments for a plan file:
1. Open the plan file.

2. On the Axiom tab, in the File Options group, click File Attachments.

NOTE: In systems with installed products, this featuremay be available in a different location.
It may be located on a different ribbon tab, or in a task pane, or by double-clicking a
designated area within the plan file itself.

One of two dialogs will open, depending on your level of rights to the plan file:
l Users with read-only access see the Browse Attachments dialog, to view existing attachments.
l Users with read/write access see theManage Attachments dialog, to view and manage

attachments.

NOTES:
l The features described in this topic apply to spreadsheet plan files. If you are using browser-

based plan files (Axiom forms), the same general functionality is available, but the user
interface is different. For more information, seeWorking with file attachments (in Web Client
help).

l This topic explains how end users can view and manage file attachments for their plan files. If
you are an administrator and want to learn more about enabling this feature for file groups
and managing it at the file group level, see the File Group Administration Guide.
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� Browsing file attachments
The Browse Attachments dialog lists all current file attachments for the plan file. To open an attachment,
select the file in the list and click Open (or you can double-click the file).

How the attachment opens depends on the type of attachment. Excel-compatible files will open directly
in the current Axiom Software session, in a new tab. Other file types will open in their native application—
such as Word for a DOCX file, or Adobe Reader for a PDF file—assuming that application is present on
your computer.

� Managing file attachments
Using theManage Attachments dialog, you can add, delete, and view attachments for a plan file.

l Adding a file attachment: Click Upload Attachment, and then navigate to the file that you want
to add as an attachment. The file will be imported into the Axiom Software database and
associated with the plan file.

l Deleting a file attachment: Select the file that you want to delete, and then click Delete. The file is
deleted from the Axiom Software database and will no longer be available as an attachment.

l Renaming a file attachment: To rename a file attachment, right-click the attachment and then
click Rename. The name becomes editable and you can type your changes.

l Editing the attachment description: To define or edit the description for the file attachment,
select the file and then click Edit Description.

l Opening a file attachment: Select the file that you want to open, and then click Open (or you can
double-click the file).

If the attachment is an Excel-compatible file that opens within the Axiom Software session, it will open
with read/write access. You can edit the file and save changes if desired.

If the attachment is a Word file or a PowerPoint file, then it opens in its native program with read/write
access if the corresponding Axiom Software add-in is already installed (or if it is successfully installed
when the file is opened). You can edit the file and save changes by using the add-in.

If theWord or PowerPoint add-in is not installed, or if the file is some other file type, then you cannot
edit and save the file directly. If you need to edit one of these files, you should save a copy of the file
locally and make your edits. You can then delete the existing file attachment in the Axiom Software
database, and upload your edited copy.

Saving a plan file
When you save a plan file, the following occurs:

l The plan file is updated in the Axiom Software file system.
l Data from the file is saved to the Axiom Software database.
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To save a plan file:
l On the Axiom tab, in the File Options group, click Save. (In systems with installed products, this

featuremay be located on theMain tab.)

Before saving data to the database, Axiom Software performs an Excel calculation to update all formulas
in the sheet (including any Axiom functions), and validates the file. If errors are found, the file is still saved
but the data save is stopped and errors are displayed in the Save Errors pane. These errors must be
corrected before data can be saved to the database.

If no errors are found, then the file and data are saved and a confirmation message displays. The
confirmation message includes information about the number of records saved (click Show Details to
see this information if desired).

NOTES:
l Your file group security permissions determine whether you can save a plan file and/or save

data to the database.

l If the plan file is part of a plan file process or a workflow, then your ability to save the plan file
may depend on whether you are the current task owner of the plan file. Also, if you are the
current task owner, then you may be prompted to complete your active task as part of the
save process.

l The save-to-database process only occurs if the file is configured to save data to the database.
However, most plan files are configured to save to the database.

If the plan file is open as read-only, then it cannot be saved. Exception: some implementations may use a
combination of read-only and save data permissions, where the plan file is a static input form and only
data is saved to the database.

� Additional save options
When you click the Save button, Axiom Software automatically performs all save actions that your user
rights allow and that the file is configured to perform. This is the default save behavior that should be
used in themajority of cases. If necessary, you can use additional save options to only save the plan file,
or to only save the data.

For example, you may be in the process of inputting planning data into the file, and you don't want to
save the data to the database until you have finished all your inputs. You can save just the plan file while
you are working, and then when you are finished, perform a normal save.

IMPORTANT: If you save a plan file without performing a save-to-database (or vice versa), this may
cause a mismatch between the data in the file and the data in the database. Ideally, the plan file save
and the save-to-database should occur together, so that the database and plan files remain in synch,
and so that you can always track how a plan value was calculated.
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To save only the file:
l In the Axiom tab, in the File Options group, click the down arrow to the right of the Save button,

and then click Save File Only.

The plan file is saved. All save-to-database processes are ignored.

To save only the data:
l In the Axiom tab, in the File Options group, click the down arrow to the right of the Save button,

and then click Save Data Only.

Data from the file is saved to the database. The file itself is not saved.

NOTE: In systems with installed products, the additional save options may be located on theMain
tab, or the options may not be available.

� Saving a copy of a plan file
If you want to save a copy of a plan file for archive purposes, or to provide a copy to a non-Axiom
Software user, the best approach is to take a snapshot of the plan file. The snapshot process converts
the file to a regular Microsoft Excel file that can be used outside of Axiom Software. Keep in mind that
Axiom formulas will be converted to values, so in some cases you may not be able to tell exactly how a
plan value was calculated. For more information, see Taking a snapshot copy of an Axiom file.

Although the Save As (Local) option is available for plan files, generally it should not be used to save
copies of plan files. Once a copy of a plan file is saved outside of its file group, the plan file becomes
disconnected from the file group and certain functionality will be lost. End users do not have a way to
"restore" the copy to the file group. Save As cannot be used to create plan file "versions."

Completing a task in a plan file process
Plan files in a file group can be part of a defined planning process, which is a set of steps for plan files to
progress through during a planning cycle. For example, you may have a basic process with two stages:
one for managers to develop the plans, and one for the Finance department to review and approve
them. Or you may have a multi-step plan which includes several passes of plan development, and
multiple levels of review.

For each defined step of the process, each plan file has a designated owner. When the plan file is in a
step, that owner has a plan file "task" to perform one of the following actions:

l Edit the plan file and then submit it to the next step.

OR

l Review the plan file and then approve it or reject it.
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If you are a plan file owner, then you will be assigned a task and you will see that task in the Process task
pane. You can review your assigned tasks and open the associated plan files using this task pane. You
may also be notified of the task via email.

Example Process task pane with active tasks

If you are assigned a plan file task, it is your responsibility to complete the task by the specified due date.
You can open the plan file from the appropriate task pane (or using the normal file group menus) and
perform the necessary edits or review. When you are finished, you can complete the task from the
appropriate task pane. You may also have the option of completing the task as part of saving the file.

NOTE: When you are a plan file owner, your permissions to the plan file may be "elevated" as
necessary so that you can complete the current task. For example, under normal circumstances you
might have read-only access to a particular plan file. But if you are assigned a task that requires you
to edit a plan file, then your permissions will be elevated as needed so that you can edit the file and
save its data. Once you have completed the task, your permissions will return to normal levels.

When you have finished editing or reviewing a plan file for which you are the currently assigned owner,
you must complete the associated process task. You can complete this task using the Process task pane,
or as part of saving the plan file.

� Completing a plan file task using the Process task pane
You can complete your current process tasks using the Process task pane.

1. On the active step in the Process task pane, click one of the following actions (depending on the
step type):

l For edit steps, clickMark step as complete. This moves the plan file to the next step.

l For approval steps, click Process Actions > Approve if you approve the plan file and want
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to move it to the next step. Click Process Actions > Reject if the plan file needs more work,
and you want to return it back to the prior step.

NOTE: Some plan file processes may have an additional action ofDeny request (or a
similar customized name). The deny action causes the plan file to be aborted in the
process, so that it no longer progresses in the process. This action is intended for cases
where the plan file should be completely removed from the process and never
approved.

If you currently havemore than one active plan file in a step, you can select a plan file before
clicking the appropriate action, and that plan file will be pre-selected for completion in the Process
Action dialog. You can also right-click a plan file to perform any of these actions.

2. In the Process Action dialog, do the following:
l If you currently havemultiple active plan file tasks for this step, select the check boxes for

the plan file tasks that you want to complete right now. If you only have one active plan file
task (or if a plan file was selected in Process task pane before clicking the action), then that
plan file is selected automatically and no check boxes display.

l You can optionally enter a comment to be stored in the process history and included in the
email to the next stage owner (if notifications are enabled).

Example action dialog for multiple active tasks

3. Click OK to complete the task.

Once the background tasks are complete and the plan file has been moved to the next (or prior) step,
then you are no longer the step owner and the task no longer displays as active in the task pane.
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� Completing a plan file task when saving a plan file
Your system may be configured so that when you save a plan file for which you have an active process
task, you are given the option to complete the task after the save occurs.

NOTES:
l The option to complete a plan file task while saving is only available if the plan file is in a step

that allows edits. If the plan file is in an approval step that does not allow edits, then you must
use the Process task pane to complete the task.

l This option only applies to spreadsheet plan files. If you are working on a form-enabled plan
file, there is no way to prompt the user to complete the task as part of a save. Instead, the
plan file may contain a button that allows you to complete the current task.

If the save is successful, a dialog similar to the following opens:

This dialog provides information about the current step for the plan file, as well as the next step and the
prior step (if applicable). Using this dialog, you can select one of the following options:

l Leave in current step (default): You will remain the plan file owner and you can continue to work
on the plan file.

l Advance to next step: Select this option if you are done working on the plan file and you are
ready to advance it to the next step. In most cases this means that you will no longer be the plan
file owner and you can no longer edit the plan file.

l Return to previous step: Select this option if you want to "reject" the plan file and return it to a
previous step. This option is only available if the current step is an approval step. In most cases
this means that you will no longer be the plan file owner and you can no longer edit the plan file.

Some plan file processes may have an additional action ofDeny request (or a similar customized name).
The deny action causes the plan file to be aborted in the process, so that it no longer progresses in the
process. This action is intended for cases where the plan file should be completely removed from the
process and never approved. For example:
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If you choose any action other than leaving the plan file in the current step, then you can enter an
optional comment to be saved in the process history and included in the notification to the next step
owner (if notifications are enabled).

This process dialog only displays if your system has been configured to prompt users about process
tasks when saving. Otherwise, you must use the Process task pane to complete plan file tasks.
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Using Reports
Axiom Software reports can query data from any table in the Axiom Software database. This section
provides basic information about spreadsheet-based Axiom reports, and explains how to open existing
reports and refresh them with data.

For information on how to set up the data query for a report, and how to configure other Axiom file
options, see the Axiom File Setup Guide.

In addition to the report-specific functionality detailed in this section, you can use standard Axiom file
features and tools. Report files use the same functionality as other Axiom files to perform actions such as
changing views or navigating to file bookmarks. For more information, see Using Axiom File Features and
Printing Files and other File Output Options.

About reports
Reports use Axiom file functionality to bring in data from the database, and if desired, to save data back
to the database. You can use any Axiom file feature in a report except calc method libraries.

Report files, unlike other Axiom files, are not associated with any file group. You can bring in data from
any table. For example, if you have two file groups that are configured to save data back to two different
tables (or to different columns in the same table), you can use a report to compare the data.

� Report structure
Axiom reports are free-format. When you create a new report, you can use various query options to
bring data anywhere into the report, and you can use spreadsheet functionality to format the report and
calculate values such as subtotals and percentages.

Reports can have any number of sheets. Each sheet can be configured to bring in data from the
database, and, if desired, save data back to the database. If you want to use an Axiom query on a sheet,
or save data to the database from a sheet, that sheet must be configured on the Control Sheet. Other
Axiom file functionality, such as Axiom functions or GoTo bookmarks, do not require the sheet to be
configured on the Control Sheet.

4
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� Reports Library
Report files are stored in the Axiom Software database. To make it easy to access and organize reports,
Axiom Software supports a virtual folder structure known as the Reports Library.

Each report is assigned to a folder in the Reports Library. When you open reports, you can navigate
through the Reports Library structure to quickly locate the report that you want to open.

The Reports Library is managed by using Axiom Explorer. If you are an administrator, or if you have
Administer Axiom Explorer rights, then you can use Axiom Explorer to create report folders, move
reports between folders, and delete existing reports. For more information on using Axiom Explorer, see
the System Administration Guide.

You can also save reports outside of the Axiom Software database—for example, to your local computer
or to a network folder. In this case the file is considered to be a non-managed file. It is recommended to
maintain all reports as managed files unless you have a compelling reason to use a non-managed file.

� Report output and distribution
In addition to the standard output options for Axiom files—such as the ability to take a snapshot of an
Axiom file—report files can use the File Processing feature.

Using file processing, you can refresh a report file and perform output and distribution actions such as
saving a snapshot copy of the file, emailing a snapshot copy of a file, or exporting data to a CSV/TXT file.
You can process the file "as is," or perform multipass processing on the file, where the file is processed
multiple times using a unique filter for each pass.

For more information, see Processing a report.

� Saving data to the database
In addition to viewing data, you can also use reports to calculate data and save data back to the
database. In certain circumstances, it may bemore appropriate to use a report to save data rather than
plan files or driver files. If a report file has been configured to save to the database, you can use the Save
button in the File Options group to save data.

Contact your Axiom Software consultant if you are unsure about the best way to manage a certain set of
data.

Opening a report
Axiom Software reports are organized by folder in the Reports Library. The specific report folders and files
that you can access and the level of access rights depend on your security settings. Administrators have
full access to all reports.
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To open a report in the Reports Library:
1. On the Axiom tab, in the Reports group, click Reports to bring up the Reports menu.

TIP: You can also open reports from the Explorer task pane or Axiom Explorer.

2. Do one of the following:

l Click All Reports to view all reports within an Axiom grid. You can then select one or more
reports to open. You can sort, filter, and group the list using standard Axiom grid features.
For example, you can find a report by name by filtering on the Document Name field.

l Use the Reports Library folders at the bottom of themenu to navigate to the specific report
that you want to open. Report folders may have sub-folders.

NOTE: If another user adds a file or a folder to the Reports Library during the current session,
it may not be immediately visible to you. You can refresh your view by selecting Reports >
Refresh File System.

The selected report opens. If a report was opened read-only, then the text (R/O) displays in the file tab.
Read-only reports cannot be saved.

NOTE: If another user has the report open as read/write, then you can only open the file as read-
only, regardless of your security permissions.

� Advanced options
l If you want to open a report without refreshing Axiom queries that are configured to refresh on

open, right-click the file and then select Open Without Refresh. This option is only available to
administrators.

l If you have read/write permissions to a report but you want to open it as read-only to prevent
locking the file from other users, right-click the file and then select Open Read Only.

� Opening non-managed report files
If you have a non-managed report saved to your local drive or a network folder, you can open it as
follows:

l In the Excel Client, use standard Excel functionality to open the file within Axiom Software.
l In theWindows Client, click the Axiom button in the top left-hand corner. Click Open and then

navigate to the file.
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Creating a new report
You can create a new report if you have read/write access to at least one folder in the Reports Library.
You can use any of themethods discussed below to create a new report. If you do not have these
permissions, then the associated menu options for creating new reports will not be available to you.

NOTE: After saving a new report to the Axiom file system, you may not see that new report displayed
in Axiom Explorer or the Reports menu until the file system has been refreshed. You can go to
Reports > Refresh file system to manually trigger a refresh and cause the new report to display.

� Creating a new report using the Report Wizard
You can create a new report using the Report Wizard. In the wizard, you make selections regarding the
type of report that you want to create and the desired data, and then the wizard creates a report based
on your choices. You can then further modify the report as needed.

To create a new report using the Report Wizard:
l On the Axiom tab, in the Reports group, select Reports > Report Wizard.

For more information on how the Report Wizard works and what types of reports can bemade using the
Report Wizard, see the Axiom File Setup Guide.

� Creating a new blank report
You can create a new report "from scratch" using the default blank report template. This template is
entirely free-format.

If your organization has saved additional report templates, you can use those to create a new report as
well. Only administrators can create new report templates.

To create a new blank report:
l On the Axiom tab, in the Reports group, select Reports > New Report.

If your system has multiple report templates, you can select the template that you want to use
from this menu. Otherwise, the default ReportTemplate is automatically used.

A new report file opens, containing a Control Sheet and one or more blank sheets. Give one of the blank
sheets a name and configure it on the Control Sheet. You can use the Sheet Assistant to do this, or you
can manually type the sheet name into the Control Sheet.

You can now use Axiom file functionality on this sheet, such as using Axiom queries to bring in data. For
more details on setting up Axiom files, see the Axiom File Setup Guide.

Certain features do not require the sheet to be set up on the Control Sheet. For example, if you only
want to use Axiom functions to query data, such as GetData, then you do not have to use the Control
Sheet. However, in most cases you will want to configure used sheets on the Control Sheet.
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� Saving a new report
To save a new report, click Save in the File Options group of the Axiom tab. When you save the new
report for the first time, you are prompted to define a file name and select a folder location in the
Reports Library. You can also define a description for the report.

You must have read/write permissions to a folder in order to save a report there. A lock icon displays
next to folders where you do not have read/write permissions. If you have access to a My Documents
folder, you can also save reports there for your own use.

If you later want to change the file name, location, or description, you can use Axiom Explorer. If you do
not have rights to access Axiom Explorer, you can edit the description by using Save As (Repository)
(save the file with the same name and location, but edit the description).

You can also choose to save the report to your local drive or to a network location, by using Save As
(Local File). In this case the report is not stored in the Axiom Software database and is considered to be a
non-managed file.
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NOTE: Access to certain task panes (such as the Sheet Assistant) may depend on security
permissions defined at a folder level. When a new report file is created, the file location is assumed to
be the root of the Reports Library until the file is saved. Therefore access to task panes for brand new
reports depends on the user's permissions defined at the Reports Library level. If a user does not
have permission to the task panes at the Reports Library level but does have access at a sub-folder
level, then the user will not see the task panes until they save the file to that sub-folder.

� Creating a new report based on an existing file
You can use Save As to create a new report based on a copy of an existing report. You can save the
copied file to the Reports Library, or as a local non-managed file.

You can also create a report based on an existing Excel file, by opening the Excel file in Axiom Software. If
you want to use certain Axiom file features such as Axiom queries, you must add a Control Sheet to the
report. Then you can use Save As (Repository) to save the file to the Reports Library.

Refreshing a report with data
To update a spreadsheet Axiom report with themost current data from the database, refresh the file. A
refresh does the following:

l Updates active Axiom queries with data, according to the update settings defined for the query
l Updates Axiom functions with data
l Performs an Excel calculation
l Reapplies the currently active views (if applicable)

To refresh a report:
l On the Axiom tab, in the File Options group, click Refresh.

This refreshes all sheets in the workbook. If you want to refresh the current sheet only, click the
down arrow on the right-hand side of the Refresh button, and then click Refresh Active Sheet.

In systems with installed products, this featuremay be located on theMain tab.

You may be prompted to define values before the refresh occurs. If so, these values will be applied to the
report to impact the data refresh.

TIP: You can also use F9 to refresh the entire workbook, and SHIFT+F9 to refresh only the active
sheet.

NOTE: Administrators can use the Refresh command on the Axiom Designer tab to perform more
targeted refresh actions, such as refreshing only a specific Axiom query.
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Applying a Quick Filter to a report
Using the Quick Filter feature, you can apply a temporary filter to a report. This allows you to quickly view
the data at a different level of detail, without needing to alter the report configuration.

For example, you may be viewing an Income Statement report for the entire consolidated organization,
and you want to view the same report at a different level of detail, such as for just North America or just
the South region. You can use the Quick Filter to recalculate the report at the desired level of detail, and
then clear the filter when you are done.

The Quick Filter is combined with your table security filters and any filters that are currently defined in
the report, such as sheet filters and filters defined for Axiom queries.

To apply a Quick Filter to a report:
1. On the Axiom tab, in the File Options group, click Quick Filter.

NOTE: In systems with installed products, this featuremay be located on theMain tab.

2. At the top of the dialog, specify how the filter should be applied:
l Workbook (default): The Quick Filter is applied to all sheets in the workbook.
l Active Sheet: The Quick Filter is only applied to the currently active sheet.

This selection may determine which hierarchies and tables are available in the dialog to build the
filter. See Hierarchy and table availability in the Quick Filter dialog.

3. In theQuick Filter dialog, define a filter using one of the following methods:

l Data Hierarchies: Select the desired hierarchy levels(s) from the hierarchies listed in the
dialog. As you select items in the hierarchy, the corresponding filter is automatically built in
the Filter box.

For example, you might have a hierarchy named Geography, which has local regions rolling
up into countries, and countries rolling up into world regions. You can select the desired
items that you want to see in the report, such as Europe, Asia, or North America as world
regions. For more information and examples, see Understanding hierarchy-based Quick
Filters.

l Manual Filter: You can manually type a filter into the Filter box using standard filter criteria
statement syntax. Fully qualified Table.Column syntaxmust be used.

l Advanced Filter: Click Advanced Filter to create a filter using any reference table columns
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(not just hierarchy columns).

Example Quick Filter dialog

4. Click OK.

If the Quick Filter is applied to the entire workbook, a warning message informs you that the
entire workbook will be refreshed. If you do not want to see this message again in the future,
select Don't show this message again. Click OK to continue.

If the Quick Filter is applied to the current sheet, that sheet is refreshed and no warning message
appears.

If the file has been configured with GetCurrentValue("QuickFilter") functions, then these functions will
display the currently applied Quick Filter for your reference. If not, you can view the current Quick Filter
by clicking theQuick Filter button again. The current filter displays in the Filter box.
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� Clearing the Quick Filter
Once a Quick Filter has been applied to a report, the filter remains applied until one of the following
occurs:

l The file is closed. Quick Filters cannot be saved in the file and are always cleared when the file is
closed.

l A newQuick Filter is applied by using theQuick Filter button and selecting a different filter.
l The Quick Filter is manually cleared. To clear the Quick Filter, click theQuick Filter button again

and then click Clear Filter.

� Hierarchy and table availability in the Quick Filter dialog
The hierarchies and tables shown in the Quick Filter dialog are based on the Axiom queries in the report.
Axiom Software looks up the primary tables for the queries, and only shows the hierarchies and
reference tables that are relevant to those primary tables. This is done to help ensure that the Quick
Filter will be applicable to at least one query in the report.

If the filter applies to the entire workbook, then Axiom Software looks at the primary tables for all Axiom
queries in the workbook. If the filter applies to the active sheet only, then Axiom Software looks at only
the primary tables for the Axiom queries defined on the active sheet.

NOTE: In the Advanced Filter view, only reference tables are shown unless the primary table has
potentially ambiguous lookup relationships. In that case, the primary data table is also shown so
that the selections can bemade directly on these lookup relationships, to avoid any ambiguity. For
example, if the primary data table has columns PrimaryPhysician and SecondaryPhysician that both
look up to Physician.Physician, then the selection must bemade through the primary data table so
that the correct path to Physician.Physician is used.

If the report uses GetData functions instead of an Axiom query, then all hierarchies and reference tables
are listed in the dialog because Axiom Software cannot determine the "primary table" in this context. In
this case, it is possible to define a Quick Filter that does not apply to any GetData functions in the
workbook. If this occurs, the filter will simply have no effect.

� Understanding hierarchy-based Quick Filters
When you use hierarchies to create a Quick Filter, Axiom Software automatically creates the filter based
on your selections. When only one item it selected, the filter is simple—only data that matches the
selected item is included. For example, if you select Asia from a Geography hierarchy, you will get a filter
something like: Dept.WorldRegion='Asia'.

User Guide Axiom Software │ 67



Simple Quick Filter

NOTE: Sometimes when you select a single "child" item underneath a "parent" item, the child and
parent will be joined with AND. For example: DEPT.VP='Jones' AND DEPT.Manager='Smith'.
This means that the DEPT table has other instances ofManager Smith that belong to different VPs,
so the compound statement is to ensure that you only get the data whereManager Smith is under
VP Jones. (You can manually edit the filter to remove the Jones portion of the statement if you want
to see all data for Manager Smith, regardless of VP). If instead Axiom Software constructs the filter as
just Dept.Manager='Smith', that means all instances ofManager Smith are also under VP Jones.

You can select multiple items in the same hierarchy or from different hierarchies. Items from the same
hierarchy are combined using OR, which means data matching any of the selected items is included.
Items from different hierarchies are combined using AND, which means only data that matches both
selected items is included.
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Example 1

In example 1, we have selected two items from the same grouping level in a single hierarchy, so a simple
filter criteria statement is created using IN. The resulting filter will include all data from Asia and Europe.
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Example 2

In example 2, we have selected two items from different grouping levels, but within the same hierarchy.
In this case a compound filter criteria statement is created using OR. The resulting filter will include all
data that belongs to either Italy or US East.
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Example 3

In example 3, we have selected two items from different hierarchies, so a compound filter criteria
statement is created using AND. The resulting filter will include only data that belongs to both US East
and VP David Prince.

Saving a report
When you save a report, the report file is updated in the Axiom Software file system. If the report is
configured to save data to the database, a save-to-database also occurs.
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To save a report:
l On the Axiom tab, in the File Options group, click Save. (In systems with installed products, this

featuremay be located on theMain tab.)

Your file permission settings in Security determine whether you can save a particular report. If a report is
open with read/write permissions, then you can save it. If the report is open as read-only, then the
report file cannot be saved, but you may still be able to save data. You may also be able to save a copy of
the report.

NOTE: Some files may use a Control Sheet setting that causes the data in the report to zero when the
file is saved. This is a security precaution that is normally enabled in reports only. You can click
Refresh to restore the data.

� Save-to-database reports
Some reports may be configured to save data to the database. If the report is configured to save to the
database, then the file is validated before saving. If errors are found, the file still saves but the data save
is stopped and the errors are displayed in the Save Errors pane. These errors must be corrected before
data can be saved to the database. If no errors are found, then a confirmation message displays, with
information about the number of records saved.

Your file permission settings in Security determine whether you can perform a save-to-database for a
particular report. Note that the permission to save data is managed separately from the file access
permission. Therefore, it is possible that you could have read-only permissions for the file, but still have
rights to save data (or the opposite—you could have read/write permissions for the file, but not have the
rights to save data).

When you click Save, Axiom Software automatically performs all save actions that your user rights allow
and that the file is configured to perform. If desired, you can use the additional save options to only save
the file, or to only save data.

To save only the file:
l In the Axiom tab, in the File Options group, click the down arrow to the right of the Save button,

and then click Save File Only.

The plan file is saved. All save-to-database processes are ignored.

To save only the data:
l In the Axiom tab, in the File Options group, click the down arrow to the right of the Save button,

and then click Save Data Only.

Data from the file is saved to the database. The file itself is not saved.

NOTE: In systems with installed products, the additional save options may be located on theMain
tab. In all systems, you can also access these options by right-clicking the file tab.
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� Saving a copy of a report
You can save a copy of a report using Save As features. You might want to save a copy of a report to use
as a starting point to create a new report, or to create an archive copy beforemaking changes to the
report.

In most cases, you should save the report to the Axiom Software file system (in the Reports Library).
However, it is possible to save report files outside of the Axiom Software system (as non-managed files).
Non-managed files have limited functionality, and are not covered by Axiom Software security or
included in system processes.

To save a copy of a report to the Reports Library:
1. On the Axiom tab, in the File Options group, click the down arrow to the right of the Save button,

and then click Save As (Repository).

TIP: The Save As options are also available by right-clicking the file tab.

The Save As dialog opens, displaying the contents of the Reports Library.

NOTE: By default this dialog only displays files with the same file extension as the current file. If
you want to view all file types when using this dialog, select View > Show All Files. This setting
will be remembered.

2. In the left-hand side of the dialog, navigate to the folder in the Reports Library where you want to
save the file.

You must have read/write permissions to a folder in order to save a copy of the report there. A
lock icon displays next to folders where you do not have read/write permissions to any folder in
that folder tree.

3. In the File name box, type a name for the new report.

4. Optional. In theDescription box, type a description for the report.

5. Click OK.

To save a copy of a report locally (as a non-managed file):
1. On the Axiom tab, in the File Options group, click the down arrow to the right of the Save button,

and then click Save As (Local File).

TIP: The Save As options are also available by right-clicking the file tab.

The Save As dialog opens.

2. Navigate to the desired location on your local computer or on a network file share, and then click
Save.
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You can change the name of the file and its file format when saving. In the Excel Client, you can
save the file using any file format that your Excel version supports. In theWindows Client, you can
save the file as XLSM, XLSX, or XLS.
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Using Axiom File Features
Axiom files support a number of features that can be used in plan files, reports, and any other type of
Axiom file.

Changing views in an Axiom file
If views have been defined for a sheet in a spreadsheet Axiom file, you can change the view to change
how information is presented in the sheet.

For example, you might have the option to switch between a Detail sheet view and a Summary sheet
view. You might have the option to toggle certain rows and columns as hidden or shown, such as to
select which quarters you want to view. The specific view options available depends on the file design.

To change the views in a sheet:
l On the Axiom tab, in the File Options group, click Change view.

NOTE: In systems with installed products, this featuremay be located on theMain tab.

This displays a menu showing all views defined in the current sheet. You can click on a view name to
activate that view.

Some views are single-selection, which means that activating one view deactivates the prior view. Other
views allow for "additive" selections so that multiple views can be active at one time. Some views may
open a dialog where you can select specific sets of rows or columns to show. The specific behavior of
each view depends on the file designer. Ideally the name of the viewwill give you a good idea of what to
expect when that particular view is selected.

After any view is made active, the freeze panes setting for the sheet is also reapplied. Axiom Software
keeps track of the currently active views in a sheet and will reapply them after you perform certain
activities in a sheet, such as refreshing an Axiom query or inserting a calc method.

Jumping to GoTo bookmarks in an Axiom file
If an Axiom file has bookmarks defined in the file, you can go directly to bookmarked points by using the
GoTo feature.

5
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To go to a bookmark:
l On the Axiom tab, in the File Options group, click GoTo.

NOTE: In systems with installed products, this featuremay be located on theMain tab.

A list appears underneath theGoTo button, listing sets of bookmarks. For example, theremay be a set of
bookmarks for each sheet in the file.

Selecting a set brings up a list of bookmarks in that set. Click a bookmark in the list to go directly to that
area.

Example GoTo bookmarks

Freezing or unfreezing panes in a sheet
Sheets in Axiom files can be configured to freeze panes at a certain location automatically when the file is
opened. You can toggle these frozen panes on and off by using the Freeze Panes option.

This option is only available if the sheet is not protected. If you have security rights to unprotect the
sheet, the Freeze Panes option will become available once the sheet is no longer protected.

To freeze or unfreeze panes in a sheet:
l On the Axiom tab, in the File Options group, select or clear the Freeze Panes check box.

NOTE: In systems with installed products, this featuremay be located on theMain tab.

If panes are frozen, clearing the check box unfreezes the panes.

If panes are unfrozen, selecting the check box freezes the panes. If a sheet has freeze panes settings
configured on the Control Sheet, selecting the check box applies that setting, regardless of where your
cursor is in the spreadsheet. Otherwise, the Freeze Panes option works like theMicrosoft Excel feature,
and freezes panes at the current cursor position.
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NOTE: If you have toggled freeze panes off, and then you use Change view to select a view (or if you
otherwise perform an action that causes a view to be reapplied), the freeze panes settings for the
sheet are reapplied.

Administrators can alternatively use the Show Everything command to turn off all protections and
display controls at once, including frozen panes.

Drilling the data in an Axiom file
Axiom Software provides various options to drill the data in an Axiom file:

l Drill down. You can "drill down" a data row to view the data at a different level of detail. If
hierarchies have been set up for your data, you can drill down predefined hierarchy levels. You can
also drill down to the "bottom" of the data or choose any relevant column for drilling.

l Drill through. You can "drill through" the data in a specific cell to view the associated sub-GL detail
or transactional data. This feature is only available if drill through has been enabled for the source
data, using drill-through definitions.

l Custom drilling. You can drill data using Axiom Software's custom drilling feature. Custom drilling
is extremely flexible and can be set up to drill virtually any source data, to any user-defined drilling
level. Custom drilling must be set up in advance for the report, and requires advanced report
writing knowledge to configure.

Drilling data: Using Drill Down
You can drill down a row in an Axiom file to view the data at a different level of detail. For example, if a
row of data in the report shows budget totals for the Northwest region, you can drill the row to see the
values for each individual department in that region. This type of drilling is known as "drilling down."

Drilling down can be used in report files or plan files, but themost typical use case is in reports. In plan
files, most data is already at the lowest level of detail, so drilling down may only be useful if the plan file
has a summary sheet with drillable data.

If a row is eligible for drilling, you can drill down hierarchies that have been set up for the data. For
example, your system may have a Geography hierarchy such as: Country > Region > DEPT. You can also
choose to drill directly to the "bottom" of the data (all dimensions), or drill using any related column in
the data.

You can drill data rows that result from an Axiom query or that are built using GetData functions. A few
limitations apply, and some advanced configurations have special behaviors. For more details, see the
drill down setup discussion in the Axiom File Setup Guide.
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Drilling can be disabled on a per sheet level. If drilling has been disabled for a sheet, then the Drill option
is disabled while you are on that sheet. This may be done if the data on the sheet is not conducive to
drilling.

To drill down a row of data:
1. Place your cursor in the row of data that you want to drill.

If you are drilling a row of data that is part of a multiple-row calc method, then you can place your
cursor anywhere in themultiple-row calc method. The drill results will be for all rows of the calc
method.

2. On the Axiom tab, in the File Options group, click Drill, and then select the desired drill level from
theDrill Down sub-menu.

NOTE: In system with installed products, this option may be located on theMain tab.

Drill option Description

Hierarchies Your system may have defined hierarchies that outline logical drilling
paths. For example, you may have a Geography hierarchy that allows
you to drill from Country to Region to individual departments.

Hierarchies are defined per dimension (on the relevant reference
table), and are specific to your system.

On theDrillmenu, hierarchies are listed first if defined. Only
hierarchies relating to the current data are shown.

NOTES:
l If the data to be drilled comes from multiple data tables, then only

the hierarchies from shared lookup reference tables are available.
l If you are drilling an Axiom query, hierarchy options will be grayed

out on themenu if you are already at that level of detail. For
example, if the report is at the VP level already, VP is grayed out on
themenu. However, when you are drilling GetData functions, all
hierarchy options are present on themenu, because the GetData
functions may all have different "sum by" levels.

User Guide Axiom Software │ 78



Drill option Description

All Detail Selecting All Detail takes you directly to the very "bottom" of the
data. Essentially, you are drilling based on all dimensions at once,
rather than on one specific dimension.

The drill sheet will contain one column for each dimension (key
column) in the data, including a description column for each (if
applicable).

NOTE: If the row contains data from more than one data table, then
this option is only available if the tables share the exact same key
columns and all of the key columns are lookup columns.

Choose Columns Selecting Choose Columns allows you to drill based on any relevant
column for the current data, including non-lookup key columns.

In the Select Columns dialog, select the column (or columns) that you
want to drill by. You can select from any column in the primary data
table, as well as any column in lookup reference tables.

This drilling option is entirely free-format. There is no validation to
determine if a particular column selection makes sense in relation to
the current data.

NOTES:
l Calculated fields do not display and cannot be used for drilling.
l If the row contains data from multiple data tables, then only

columns from shared lookup reference tables can be selected.

A temporary file opens, named Drill_Filename.xlsx. This file contains a drill sheet named Drill_
DrillLevel, that shows the results of the selected drill. The top of the drill sheet displays your current drill
context.

If you want to continue to drill, you can do either of the following:
l Return to the original sheet (or a different sheet) in the original file, and then select a new drill

level. If you left the temporary drill file open, then a new drill sheet will be added to that file, with
the new drill results. If you closed the temporary file, then Axiom Software creates a new
temporary file.

l Select a row in the drill sheet, and continue drilling to a lower level of detail. A new drill sheet will
be created in the temporary file with the results.

When you are finished viewing the drill results, close the temporary file. While it is possible to use Save
As to save the temporary file, typically this is not useful. You can always perform the drill again at any
time to see the results. If you find yourself performing the same drill over and over, you may want to
create a new report that displays the data at the desired level. If you want to share the drill results with
someone else, the best approach is to create a snapshot copy of the temporary drill file.
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Double-click drilling
If Axiom double-click actions are enabled for the sheet, then you can drill a row of data by double-clicking
it. In this case, a dialog opens, listing the drilling options for the current row selection. Select the desired
drill level and then click OK.

NOTE: Certain double-click actions may take priority over drilling.

Drilling data: Using Drill Through
You can drill a specific data point in an Axiom file to see the associated sub-GL detail or transactional data.
This feature is only available if "drill through" has been enabled for the source data, using a drill-through
definition.

The drill-through feature can be used in either report files or plan files.

You can drill data values that result from an Axiom query or from a GetData function. A few limitations
apply, and some advanced configurations have special behaviors. For more details, see the drill through
setup discussion in the Axiom File Setup Guide.

Drilling can be disabled on a per sheet level. If drilling has been disabled for a sheet, then the Drill option
is disabled while you are on that sheet. This may be done if the data on the sheet is not conducive to
drilling.

To drill through the data in an Axiom file:
1. Place your cursor in the cell that contains the value you want to drill.

2. On the Axiom tab, in the File Options group, click Drill, and then select the desired drill from the
Drill Through sub-menu.

NOTE: In system with installed products, this option may be located on theMain tab.

IfDrill Through is not listed on the drilling menu, then the selected cell is not eligible for drill
through.

A temporary file opens, named Drill_Filename.xlsx. This file contains a drill sheet named Drill_
DrillLevel, that shows the results of the selected drill. The top of the drill sheet displays your current drill
context.

NOTE: When you drill through data, you drill from the source table to an entirely different table that
holds the detailed data. The data results are entirely dependent on the drill-through configuration
(unlike drill down, where the drill data is queried from the same table and derived programmatically).
If the drill results are not as you expect, please contact your system administrator.
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Double-click drilling
If Axiom double-click actions are enabled for the sheet, then you can drill a data value by double-clicking
it. In this case, a dialog opens, listing the drilling options for the current selection. Select the desired drill
level and then click OK.

Drilling data: Using custom drilling
If an Axiom file has been set up for custom drilling, then you can drill the data in the file to view it at a
different level of detail, or to view a set of related data. Custom drilling is most often used in reports, but
it can be applied to any Axiom file.

Each sheet can have one or more custom drilling options. Custom drilling is completely configurable and
can be set up to return any set of data. If you have any questions about the custom drill options in a
particular file, contact the report designer or a system administrator.

Custom drilling can be initiated by double-clicking a row, or by using theDrillmenu. Double-click drilling
is only available if one of the drilling options in the file has been configured to use it. Otherwise, all active
custom drills can be initiated from theDrillmenu. If custom drill options are available for the file, they
are listed under the subhead Custom Drills.

If a file is not set up for custom drilling, then only the "built-in" drilling options display on theDrillmenu.

To drill the data in an Axiom file using custom drilling:
1. Do one of the following, depending on the desired drill and how the file is configured:

l Double-click the row that you want to drill.
l Place your cursor in the row that you want to drill. On the Axiom tab, in the File Options

group, click Drill and then select a drill option listed under the Custom Drills subhead.

TIP: You can also initiate drills from the right-click context menu.

2. If the drill option requires you to select a drilling level, then theDrill dialog opens, displaying the
available levels. Select a level and then click OK.

If the drill option has just one level, then this step does not apply.

A report file opens, displaying the results of the selected drill. This target drill report is a separate file that
is opened using your normal file security rights. When you are done viewing the drill data, you can close
the report.

NOTE: When custom drilling, drill results are presented differently than when using the built-in
drilling features. Custom drilling uses a separate target report that has been specially configured to
present the drill results. You cannot continue drilling the target report unless the target report has
also been configured to support custom drilling (or unless the data in the target report is eligible for
built-in drilling).
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Printing Files and other File Output
Options

Axiom Software has a variety of features that can be used to create file output and share data with
people throughout your organization.

Printing an Axiom file
You can print a spreadsheet Axiom file on a per sheet basis. You can decide to print one or more sheets,
or all available sheets.

Each sheet can have one or more defined print views. The print views can be used to print different
"views" of the sheet, and to set certain standard print options such as the print orientation. For example,
for a plan file, you might have one print view that prints a "summary" view of the sheet (with certain
columns and rows hidden for printing), and another print view that prints a "detail" view of the sheet
(with all columns and rows visible).

If a sheet has no predefined print views, then the sheet can be printed using the settings defined for the
spreadsheet using standard Excel printing features. For more information on defining print settings for a
spreadsheet, see theMicrosoft Excel Help. In theWindows Client, the spreadsheet print settings are
defined in theWorkbook Explorer, in the Page Setup section for each sheet.

NOTE: You can always print the file using standard spreadsheet print functionality, even if Axiom
Software print views have been defined.

To print an Axiom file:
1. On the Axiom tab, in the File Output group, select one of the following:

l If you want to be able to select print views from all sheets in the workbook, click Print.
l If you want to print only the current sheet, then click the arrow to the right of the Print

button, and then click Print This Sheet.

NOTE: In systems with installed products, this featuremay be located on theMain tab—
either directly on the ribbon or under Publish.

6
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The Print Sheets dialog opens. This dialog lists the available print views for the entire workbook or
for the current sheet, depending on how you entered the dialog. To sort this list by the Sheet
Name or Print ViewName, click the column header.

Example Print Sheets dialog

NOTES:
l If a sheet does not have a defined print view, then it is listed with a print view name of

"Default," and will use the print settings defined for the spreadsheet.

l Control Sheets cannot be printed using the Axiom Software printing feature, whether
they are visible or hidden. If you want to print a Control Sheet, use the standard
spreadsheet printing features.

2. In the Print Sheets dialog, select the sheet / print view combinations that you want to print.

If you want to print all print views for all sheets, then select the check box in the column header to
select all.

If you opened this dialog by using Print This Sheet and the sheet has only one available print
view, then that view is selected by default.

3. You can also do any of the following before printing:
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l View and edit the print settings. If you want to view and potentially change the print
settings for a selected view, click the View/Edit link. In the Print Options dialog, you can
change any of the print settings, for the current print job only (the changes are not saved in
the file).

l Preview a print view. If you want to preview a print view, click the Print Preview link. The
native spreadsheet Print Preview feature will open to preview the print job. Only one view
can be previewed at a time.

l Select a printer. If you want to print to a different printer than your default printer, click
Choose Printer at the bottom of the dialog. In the Printer Setup dialog, select the printer
that you want to use, and then click OK.

NOTE: In theWindows Client, the printer is always your default printer unless you
change it for a particular print job. In the Excel Client, the printer starts as your default
printer, but if you change the printer for a print job, the changed selection will be
remembered for any future print jobs in the current session.

4. Click Print.

The selected items are printed.

Printing multiple plan files
You can print multiple plan files in batch by using the Print Plan Files feature. You can select multiple
plan files within a file group, and then select one or more print views for each plan file. The available print
views for each plan file are based on the template that was used to create the plan file.

To print multiple plan files from a file group:
1. On the Axiom tab, in the File Output group, click the down arrow to the right of the Print button,

and then click Print Plan Files.

NOTE: In systems with installed products, this featuremay be located on theMain tab—
either directly on the ribbon or under Publish.

TIP: If you have access to the file group menu for a file group, then you can access Print Plan
Files from the file group menu. In this case, the current file group is pre-selected in the dialog.

2. In the Print Plan Files dialog, use the File Group list to select the file group that contains the plan
files that you want to print.

Only one file group can be printed at a time. Once a file group is selected, the dialog displays a list
of the available plan files.
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3. In the Select plan files to print section, select the plan files that you want to print.
l You can sort and filter the list using standard Axiom grid functionality to find the plan files

that you want to print.

l To select multiple plan files at once, highlight the plan files, and then right-click and select
Select. If you want to print all plan files that currently display in the dialog, select the check
box in the header row.

Once at least one plan file has been selected, you can select which print views to print.

4. In the Select views to print section (at the bottom of the dialog), select the views that you want
to print. You must do this for each source template used for the selected plan files.

l Click the Select print views link.

l In the Select Print Views dialog, select the sheet / print view combinations that you would
like to print, and then click OK.

If you want to see the settings that will be applied to the print job, click the View link. Print
settings are read-only in this context.

NOTE: All template sheets are listed in this context (except for Control Sheets), including
sheets that you may not normally see in plan files because they are hidden. If you select
a sheet that is hidden in one of the selected plan files, it will not be printed. Amessage
will inform you of the unprinted sheet when the printing process is complete.

l Repeat this process for each source template.

If all of the selected plan files were built using the same template, then there will be only one
template listed. If the selected plan files were built using multiple templates, then multiple
templates will be listed. The print selections for each template will only apply to the plan files that
were built using that template.

5. If you want to print to a different printer than your default printer, click Choose Printer at the
bottom of the dialog. In the Printer Setup dialog, select the printer that you want to use, and then
click OK.
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NOTE: In theWindows Client, the printer is always your default printer unless you change it
for a particular print job. In the Excel Client, the printer starts as your default printer, but if you
change the printer for a print job, the changed selection will be remembered for any future
print jobs in the current session.

6. Click Print.

The selected plan files are printed, using the print view selections.

If a selected print view is not found in a target plan file, a message displays at the end of the process,
listing the affected plan file and the relevant sheet / print view. This may occur if the print views in either
the template or the plan file have been modified after plan file creation.

Taking a snapshot copy of an Axiom file
You can take a “snapshot” of a spreadsheet Axiom file, so that you can save a copy as a normal Excel file
and then open it in Microsoft Excel (without needing Axiom Software). For example, you may want to
send a copy of a report to someone that does not have access to Axiom Software.

When you create a snapshot of an Axiom file, the file is copied as an XLSX file, and the following occurs:
l All Control Sheets and any hidden sheets are automatically removed. You can choose whether to

include all remaining sheets, or only the active sheet.
l All Axiom formulas are replaced with values. You can choose whether to retain Excel formulas, or

replace them with values. If Excel formulas are preserved, certain formulas will be replaced with
values if they reference sheets or cells that are deleted as part of the snapshot processing.

l Rows and columns flagged for delete are deleted.

Due to the file format, any VBA macros in the file are also removed.

To take a snapshot of an Axiom file:
1. Open the file in Axiom Software.

2. On the Axiom tab, in the File Output group, click Snapshot.

NOTE: In systems with installed products, this featuremay be located on theMain tab—
either directly on the ribbon or under Publish.

The Snapshot File dialog opens.

3. In the Formula Replacements section, select one of the following:

l Convert All Formulas (default): All formulas are replaced with values.

l Retain Excel Native Formulas: All Excel formulas in the spreadsheet will be retained as is,
with one exception. If a cross-sheet formula references a sheet that will not be present in
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the snapshot (depending on the Sheets To Snapshot setting), that formula will be replaced
with values.

NOTE: If the file contains a pivot table, this option must be selected in order for the
pivot table to work in the snapshot copy.

4. In the Sheets to Snapshot section, select one of the following:
l Limit to Active Sheet (default): Include only the active sheet in the snapshot.
l All Sheets In File: Include all sheets in the file (except any Control Sheets and hidden

sheets, which are always removed).

5. Click OK.

The snapshot file is created and is opened in Axiom Software. The navigation tab for the file is titled either
Sheetname_snapshot (if the snapshot contains only one sheet) or FileName_snapshot (if the snapshot
has multiple sheets). You can now use Save As features to save the file locally or to a network location.

NOTE: If you are using the Excel Client and you want to save a copy of the snapshot as a PDF file, you
can use standard Excel functionality to do so. Use File > Save As, and then select PDF as the file type.
This is an Excel-specific feature that is not available in theWindows Client.

If you want to email a snapshot to someone directly, you can use the E-Mail Workbook feature. This
creates a snapshot and attaches it to an email (instead of opening it in Axiom Software).

Emailing a snapshot of an Axiom file
You can email a snapshot of a spreadsheet Axiom file using the E-mail feature. Axiom Software creates a
snapshot copy of the file and attaches it to an email. The copy can then be viewed outside of Axiom
Software by someonewho may have no access to the system. When you use this feature, Axiom
Software creates a snapshot copy of the file just like it would if you used the Snapshot feature.

The email can be sent using your default email client (such as Microsoft Outlook), or you can send the file
using the Axiom Software Scheduler email service. Note that the Scheduler email service does not
support HTML format for email.
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NOTES:
l The name of the emailed file is either Sheetname_snapshot (if the snapshot contains only one

sheet) or FileName_snapshot (if the snapshot has multiple sheets). The name cannot be
changed.

l You can also email snapshot copies using the File Processing feature. File processing is typically
used when you want to automate the process and employ multipass processing to send the
same file to different people using different data. The E-mail feature is best used to send "one-
off" snapshots as needed.

To email a snapshot copy of an Axiom file:
1. Open the file in Axiom Software.

2. On the Axiom tab, in the File Output group, select E-mail.

NOTE: In systems with installed products, this featuremay be located on theMain tab—
either directly on the ribbon or under Publish.

The E-mail Active Workbook dialog opens.

3. For Send As, select Snapshot.

4. For Send using, select one of the following:

l Outlook: Send the email using the default email client on your local machine (for example,
Microsoft Outlook). The name of this option may be customized for your organization.

l Axiom Mail Service: Send the email using the Axiom Software Scheduler email service.

5. Complete the following Snapshot Options in the dialog:

Option Description

Send file as Select XLS, XLSX, XLSM, or PDF. XLSX is selected by default.

NOTE: PDF is not available in the AxiomWindows Client.

Include Select one of the following:

l Entire Workbook: All sheets are included in the snapshot (except
Control Sheets and hidden sheets, which are always removed).

l Active Worksheet Only (default): Only the active worksheet is included
in the snapshot.
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Option Description

Formulas l Convert All Formulas (default): All formulas are converted to values.
l Retain Excel Native Formulas: Axiom formulas are converted to

values, but Excel formulas are left as is. Note that if an Excel formula
references a sheet that is not included in the snapshot, that formula
will be converted to a value.
NOTE: If the file contains a pivot table, this option must be selected in
order for the pivot table to work in the snapshot copy.

This option does not apply if PDF is the selected file type.

6. Click OK.

If you selected to send the file using your default email client, then a new email message opens, with the
snapshot file attached. You can then specify the recipient, subject, and body text for the email, and then
send it.

If you selected to send the file using the Axiom mail service, then an E-Mail dialog opens so that you can
specify the recipient, subject, and body text for the email. In the address boxes (To, Cc, and BCC), you
can either type an email address, or click the button to select an Axiom Software user. If you select a
user, the email will be sent using the user's email address as defined in Axiom Software security. When
you click OK, the email settings are saved to the database, to be sent the next time the Scheduler SMTP
Email Delivery task is run.

Notes for administrators
If desired, you can customize the name of the default email client option. By default, "Outlook" is used
becausemost customers haveMicrosoft Outlook on their client machines. To customize the name, use
theDefaultEmailClientName system configuration setting. For more information, see the System
Administration Guide.

Emailing a hyperlink to an Axiom file
You can email a hyperlink to a spreadsheet Axiom file using the E-mail feature. Axiom Software creates a
URL hyperlink to the file and includes it in an email. The email recipient can click on the link to launch the
system and open the file directly, assuming that the recipient is an Axiom Software user who has rights to
access the file.

NOTE: The email hyperlink feature is not supported for use with the Axiom Software shared client.

The email can be sent using your default email client (such as Microsoft Outlook), or you can send the file
using the Axiom Software Scheduler email service. Note that the Scheduler email service does not
support HTML format for email.
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NOTES:
l Alternatively, you can obtain a URL to an Axiom file using a variety of ways and then paste it

into an email that you createmanually. For example, you can use GetDocumentHyperlink or
right-click a file in Axiom Explorer to obtain a URL. The email hyperlink feature is provided as a
convenience to quickly send a hyperlink to the current file.

l The email hyperlink feature cannot be used to send a hyperlink to open a form-enabled file as
an Axiom form; the source file will always be opened as a spreadsheet.

l The hyperlink included in the email uses the same format as hyperlinks generated using
GetDocumentHyperlink, including the differing URL format for systems using SAML or
OpenID Authentication.

To email a hyperlink to an Axiom file:
1. Open the file in Axiom Software.

2. On the Axiom tab, in the File Output group, select E-mail.

NOTE: In systems with installed products, this featuremay be located on theMain tab—
either directly on the ribbon or under Publish.

The E-mail Active Workbook dialog opens.

3. For Send As, select Document Link.

4. For Send using, select one of the following:

l Outlook: Send the email using the default email client on your local machine (for example,
Microsoft Outlook). The name of this option may be customized for your organization.

l Axiom Mail Service: Send the email using the Axiom Software Scheduler email service.

5. Optional. Complete theDocument Link Options in the dialog:

Option Description

Sheet Filter If desired, enter a filter to apply to the file when it is opened. You can type
the filter statement or use the Filter Wizard.

The filter is applied like a Quick Filter and affects any data queries in the
file. For example, Dept.Region='West'means that all data queried will
be limited to theWest region.

If desired, you can specify a table or table type to apply the filter to, using
the same filter syntax that is available for the GetDocumentHyperlink
function. In this case you must manually type the filter syntax because the
Filter Wizard does not account for this type of syntax.
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Option Description

Cell Address If desired, specify the cell to bemade active when the document is
opened. For example:

Sheet1!D22

If the specified location would not be in view normally then the file will be
scrolled to that location; otherwise the file will open in its default viewwith
the cursor placed at that location.

6. Click OK.

If you selected to send the hyperlink using your default email client, then a new email message opens,
with the hyperlink included in the body text. You can then specify the recipient, subject, and additional
body text for the email, and then send it.

If you selected to send the hyperlink using the Axiom mail service, then an E-Mail dialog opens so that
you can specify the recipient, subject, and additional body text for the email. In the To and Cc boxes, you
can either type an email address, or click the button to select an Axiom Software user. If you select a
user, the email will be sent using the user's email address as defined in Axiom Software security. When
you click OK, the email settings are saved to the database, to be sent the next time the Scheduler SMTP
Email Delivery task is run.

Notes for administrators
If desired, you can customize the name of the default email client option. By default, "Outlook" is used
becausemost customers haveMicrosoft Outlook on their client machines. To customize the name, use
theDefaultEmailClientName system configuration setting. For more information, see the System
Administration Guide.

Processing a report
If a report is set up to use file processing, you can process the report to automatically perform actions
such as:

l Save snapshot copies of the file and automatically email them to various recipients
l Export data in the file to a CSV or TXT file
l Save data in the file to the database as part of a multipass process
l Collect multiple output files into a single report package
l Process multiple reports in batch

This topic explains how to process a file that has already been configured for file processing. For details
on how to set up a file for file processing, see the Axiom File Setup Guide.
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NOTES:
l The File Processing menu command and the associated task pane are only available to

administrators or to users with the Allow File Processing permission for the current file.
l Other file types can be set up to use file processing, but themost common use is in a report.

To process a file using file processing:
1. Open the file. If you want to see what the file is configured to do during file processing before

executing it, you can check the settings in the File Processing task pane.

2. In the File Processing task pane, in the Actions section, click one of the following options to start
processing:

l Process File: The file is processed once "as is." The file is refreshed and the file processing
action is performed. No multipass filter or settings are applied.

l Process File Multipass: The file is processed multiple times, with a unique filter applied for
each pass. For example, if the file is set up to process by DEPT, then the file is processed
once for each department. The data queries in the file are automatically filtered to return
data for the current pass department only.

The file processing settings must be configured for multipass processing. Multipass
processing does not apply if the file is configured to use batch or file collect.

TIP: You can also process the file using the File Processingmenu on the Axiom tab. (In
systems with installed products, this featuremay be located on theMain tab.)

Once file processing is initiated, the following occurs:
l The file is refreshed. If you are performing multipass processing, the file is refreshed using a data

filter for the current pass item.
l The file processing action is performed. If you are performing multipass processing, the action

may be performed after each pass, or it may be performed once all passes are complete,
depending on the file processing settings.

A status bar displays the progress of the file processing. When the processing is complete, a confirmation
box displays information about the process, such as howmany passes were performed, howmany files
were created, etc.

Note that the file itself is not saved as part of file processing. You can process a file even if you have read-
only rights to the file. However, if the file processing is set up to save to the database, you must have
rights to save data for that file.
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Reference

Axiom grids
Axiom grids are used in dialogs throughout Axiom Software, to display lists of information. These grids
offer many ways to group and filter the information.

You can change the order of columns by dragging and dropping, and you can sort by clicking a column
header.

� Filtering the list
Filtering can be especially helpful when you need to select items to include in a utility or other process.
Generally, you can filter the list to show a subset of items, and then select only the items that are shown
in the dialog.

To filter a column, click the down arrow button in the column header. This brings up a grouping and
filtering dialog for the column.

The filtering options depend on the type of column. Use one of the following:
l Equality: Select a value to show items that exactly match that value. You can select multiple values

to match.
l Contains: Type a value to show items that contain that value. For example, to show all

departments with the text "Overhead" somewhere in the name.
l Range: Specify a range of values to show items that fall within the range (inclusive). For example,

to display all departments from 20000 to 30000.

A
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Columns are filtered as soon as you select a filtering option. TheOK button on the grouping and filtering
dialog is only to close the dialog. You can press the ESC key to close the dialog and cancel the filter.

Once a column is filtered, the arrow button changes to show a filter icon , so that you know the
contents of the column are filtered. You can define filters for multiple columns.

To clear a filter for a single column, click the filter button in the column header, and then click Clear
Filters. To clear all filters, right-click in the column header and select Clear All Filters.

For example, if you want to filter the list to show a specific subset of departments, you could set a range
as follows:

If you only want to run the utility on this subset of departments, you can select the check box in the
header, and only the displayed departments will be selected.

If all of these departments belonged to the same region, or had the same VP, you could achieve the
same effect by filtering on the Region or VP column, but this time selecting a specific region or VP to filter
the list.
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� Grouping the list
To group the information by a column, click the button in the column header (it is either an arrow button
or a filter button, depending on whether the column has been filtered), and then click Group By.

The list is grouped by the selected column:
l To expand a grouping and see the items in a group, click the down arrow by a group name.
l To contract a grouping and hide the items in a group, click the up arrow by a group name.

Once the list has been grouped, a group icon appears in the column header (not on the button) to
signal which column the list is grouped by. Only one level of grouping can be applied; if you choose to
group by a different column, then the current grouping is cleared and the new grouping is applied.

To clear a grouping, click the button in the column header of the grouped column, and then click Clear
Grouping. You can also right-click the column header and select Clear All Groupings.

For example, you could group the Browse Reports Library dialog by folder path:

� Hiding and showing columns
In most grids, you can hide columns and you can display additional columns.

l To hide a column, right-click the header for that column, and select Hide ColumnName. You
cannot hide a column if it is the key column for the list.
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l To show a column, right-click anywhere in the column header to bring up the list of available
columns, and then select the desired column to add it to the grid. You can also hide columns using
this list, by clearing the check box next to the name of the column that you want to hide.

Column changes apply to the current dialog session only. The next time that you open the dialog, the
default columns display.

Axiom Software system information
The Axiom Software About box displays information such as:

l Platform version number
l Current logged in user
l Install directory
l Database server and database name
l Application server URL
l License information (number of users, expiration)
l Product feature versions (if any are installed)

To view information about your Axiom Software system:
l On the Axiom tab, in theHelp group, click the down arrow at the bottom of the Help button, and

then click About.

NOTE: In systems with installed products, this featuremay be located on theMain tab.

The information is presented in a text box, so that it can be copied and pasted into an email and sent to
Axiom Software support if necessary.

You can also update your license file from this location, by clicking theUpdate License link at the top of
the dialog.
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